Panasonic

Electronic Print Board
(Interactive Panaboard)

Operating Instructions

with Installation Manual
(for qualified service personnel)

MODEL NO. KX' B PSOO

® To assembile this unit, please refer to the Installation Manual on pages 72 through 84.

@ Before operating this unit, please read these instructions completely.
After reading them, keep them for future reference.

@ Because of the nature of the print film, all the printed text will remain on the film.

® This product is designed for installation by a qualified servicing dealer.
Installation performed by non-authorized individuals could cause safety-related problems with
the operation of this equipment.

® To locate the closest authorized dealer in your area, please call 1-800-449-8988.



Thank you for purchasing the Panasonic Electronic Print Board.
For optimum performance and safety, please read these instructions carefully.

Things you should keep a record of

Attach your sales receipt here

/For your future reference \

Date of purchase Serial number

Dealer's name and address

Dealer's telephone number

- /

@ Microsoft®, Windows®, Windows NT® and NetMeeting® are either registered trademarks or trademarks of
Microsoft Corporation in the United States and/or other countries.
Windows® is Microsoft® Windows® operating system.
Windows NT® is Microsoft® Windows NT® operating system.
NetMeeting® is Microsoft® NetMeeting® conferencing software.
@ IBM® is a registered trademark of International Business Machines Corporation.
® Pentium® is a registered trademark of Intel Corporation in the U.S. and other countries.
©® Adobe®, Acrobat® are registered trademarks of Adobe Systems Incorporated.
@ All trademarks referred to in this manual are the property of their respective companies.

Warning about saving data

When the system storage device or any of its optional storage device is adversely effected by operational errors,
static electricity, electrical noise, vibration, dust or when the power has been cut off due to malfunction, repair or
inadvertently, the memory contents may be lost or changed. Before operating the system, make a point of

reading the precautionary notes in the Operating Instructions and the help information, and observe them during
operation.

Please observe carefully the following precaution:
® Make absolutely sure that all important data is saved by back-up or the original is saved.

The manufacturer hereby declares that it cannot be held accountable for any loss or change in any data stored on
floppy disks, hard disks, optical disks, or other memory devices.




Warning Notices

WARNING: CAUTION:

TO PREVENT FIRE OR SHOCK HAZARD, DO NOT TO PREVENT RISK OF ELECTRIC SHOCK HAZARD, DO
EXPOSE THIS PRODUCT TO RAIN OR ANY TYPE OF NOT REMOVE THE COVER OF THIS PRODUCT, REFER
MOISTURE. SERVICING TO QUALIFIED SERVICE PERSONNEL.

THE SOCKET-OUTLET MUST BE NEAR THIS EQUIPMENT AND MUST BE EASILY ACCESSIBLE.

( )

Federal Communications Commission Requirements

. J

Note: This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to part 15 of the
FCC Rules. These limits are designed to provide reasonable protection against harmful interference when the equipment is
operated in a commercial environment. This equipment generates, uses, and can radiate radio frequency energy and, if not
installed and used in accordance with the instruction manual, may cause harmful interference to radio communications.
Operation of this equipment in a residential area is likely to cause harmful interference in which case the user will be required
to correct the interference at his own expense.

FCC Warning: To assure continued FCC compliance, the user must use only the provided power supply cord. Also, any
unauthorized changes or modifications to this equipment would void the user’'s warranty.

- Accessories N
® Film cassette (Blue gear(1, Green gears[J3)----- 1 @ EIECIrONIC @raser ««+ o« wrrrrrrsssesiesnsee 1
@ Thermal transfer film [20m (65.6")] -+++--eeseeuees 1 @ Eraser cloth (for Electronic eraser):--eeeeeeeee 2
® Markers (Black, Red, Blue-Big) -+ Each 1 @ Batteries (LRO3 “AAA") e 6
@ ETQSEL ++++verreerereenseeaneenteeaireesteeateesinenneenineaneens 1 @ POWET COIQ +errrrrrrrrrrrsnssssss st 1
@ Letter Papers: -« e, 20 sheets @ Interactive cable (Sm) e 1
@ PN NOIET -+ vveerreerrreerreeareeseesireesiee s e see e 2 ©® Software CD-ROM ««eereerrememmen 1
® Markers for interactive @ Operating INSLIUCHONS «++«+w+wererrrerennninn 1
(Black, Red, Blue, Green-Small) -+ Each 1 @ Software License Agreement =« e 1
@ Wall-mounting template: -« -+seesesmeeiienininns 1
N J

* The markers (Big) and the eraser are used for other than the interactive function.
* The markers for interactive (Small) are used while inserted in the pen holder.

In this manual, the pen holder with a marker for interactive (Small) is called the Electronic Pen.
The Electronic Pen and the Electronic Eraser are used with the interactive function.



Features

The KX-BP800 is equipped with two interactive functions; Projector mode and Whiteboard mode, in addition to a
regular electronic print board that utilizes plain paper. It is possible to use this product as follows.

@ Electronic print board

Functions
@ Allows copying up to 9 copies per screen
@ Allows printing in 2 level contrast (Normal/Dark)
@ Allows printing of 2-screens at the time by compressing them into a single sheet of paper

® Projector mode (Interactive function)
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Connect the Interactive Panaboard to a computer that is connected to a projector and use the projector to
project the image onto the Interactive Panaboard.

This is called the Projector mode.

In this mode, the following operations are possible:

@ Operating the computer using the Electronic Pen with its cap on as a mouse
® Drawing handwritten lines or erasing it using the Electronic Pen with its cap on in the projected image
® Saving the projected image to an image file and printing the projected image

® Recording the operations of drawing and erasing handwritten lines, playing back and editing the recorded
operations later

In Projector mode, the projected computer image on the screen of the Interactive Panaboard can be operated by
using the Electronic Pen as a mouse. You can execute the application and electronically write or erase notes.
The electronically handwritten or partially erased computer image can be stored into an image file. This will help
make your presentation more impressive to the attendants.



Features

@ Whiteboard mode (Interactive function)
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By connecting the Interactive Panaboard to a computer, the information written on the Interactive Panaboard is
displayed on the computer in real-time.
This is called the Whiteboard mode.
In this mode, the following operations are possible:
® The information written on the Interactive Panaboard using the Electronic Pen with its cap off will be
displayed on the computer screen at the same time.
® The information erased using the Electronic Eraser will be erased in the computer as well.
@ You can save drawings and notes into a file which can later be printed.
@ Allows the user to record the information being written or erased in a file that can be played back as a movie
and it can be edited if needed.

® PC Interface (Option)
When the optional PC Interface Kit (KX-BP095) is used, you can scan monochrome images from the KX-BP800
into a computer running Microsoft® Windows® or Windows NT® and print documents on the computer to the
printer of the KX-BP800.
For the operation using the PC Interface Kit, please refer to the Operating Instructions of the PC Interface Kit
(KX-BPQ95).
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* The IPB document is a Interactive Panaboard format file (extension ".ipb").



Precautions

Never remove the cover, or take apart or modify the
product. This will void the warranty.

Do not position the electronic print board in a location
where it is not stable.

Do not put drinks or other liquids on the tray.

® _

After installing or moving the electronic print board,
lock the casters and set the fall-prevention extension
legs.

Locking the casters
(Push this side)

Do not use the electronic print board in an excessively
humid or dusty location.

\

If the electronic print board is not going to be used for
an extended period of time (e.g., during extended
holidays), turn off the power and remove the plug from
the wall outlet.

o




Precautions

Installation ® Do not install the unit where it may be exposed to direct sunlight, near heating
equipment, or near air-conditioning vents as this may cause stretching and/or
discoloration of the screen.

® Do not install the unit in locations having a temperature of 10°C (50°F) or lower or
where the temperature may change suddenly as this may disable the unit’'s ability
to make copies.

Screen film @ Make thick and dark lines inside the copying 25mm (1")
area. Note that any writing inside the Em— %
shaded area on the right figure cannot i i
be copied. 35mm--= Copying area ~+{35mm

(13" || H [ 2zt
IL ----------- I ------------- lI
25mm (1)

® Use a commercially available white board cleaner for hard-to-erase stains.
(SANFORD® EXPO® white board cleaner etc.)

® Do not erase with an overly dirty eraser. (See page 65.)

® Do not allow writing to remain on the screen for an extended period of time as it
will become harder to erase.

@ Periodically wipe the screen film gently with a water-dampened cloth that has
been thoroughly wrung. (See page 65.)

® Do not touch the screen, write with markers, or erase while the screen is moving
as this may result in damage to the unit.

Markers, ® Use only the included or designated markers, erasers and thermal transfer film.

Erasers and (See page 71.)

Thermal Use of accessories other than those included or designated (such as oil-based

transfer film

markers) may damage the screen or result in hard-to-erase markings.

® Copy quality increases with the thickness of the drawn line. To ensure quality
copies, please use the markers (Big).

® The markers for interactive (Small) draw thin lines. The quality of the copies may
be reduced when these markers are used.

® Do not store the thermal transfer film in a location subject to extreme changes in
temperature (such as near air conditioning or heating equipment) as this may
cause condensation on the thermal transfer film and result in poor print quality
and/or paper jams.

@ Store markers horizontally as vertical storage may stop the ink from coming out.

® The length of one roll of designated thermal transfer film (Replacement film : KX-
BP081 or KX-BP082) is approximately 100 meters (328.1"). One roll of thermal
transfer film can make approximately 300 sheets of copies.
Note that the total number of copies may differ depending on the operating
conditions.
Also note that the length of the thermal transfer film supplied with the unit is
shorter than the replacement film roll and is only approximately 20 meters (65.6").

SANFORD® and EXPO® are registered trademarks of Sanford corporation.
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Precautions

Power cord
and Interactive
cable

® Before moving the unit, disconnect the power cord from the electrical power
socket and AC inlet, and disconnect the interactive cable from the interactive
connector and a PC. Then coil them for transportation. Failure to do these cause
the cord and cable to be damaged if they are stepped on or if they catch on
something while the unit is being moved.

Replacing the
Thermal
transfer film

@ Dispose of the used thermal transfer film in a trash receptacle for burnable trash.

® A negative of the copied image will remain on the thermal transfer film.
(To protect the security of your information, we recommend cutting up used
thermal transfer film with scissors or shredder before disposing of it.)

Electronic Pen
and

Electronic
Eraser

/\/_

@® Do not cover the transmitter with your hand while using an interactive function as
this may cause the position of the Electronic Pen or the Electronic Eraser not to
be normally detected.

@ Press down firmly with the point of the Electronic Pen or the eraser cloth of the
Electronic Eraser on the screen film until you hear a buzzing sound, and then
move it slowly.

However, do not press down the point of the Electronic Pen too much strongly as
this may make a dent in the screen back panel.

® Do not use two or more the Electronic Pens or the Electronic Eraser at the same
time as this may cause the position of the Electronic Pen or the Electronic Eraser
not to be normally detected.

@ For precise positioning, keep the Electronic Pen and Electronic Eraser
perpendicularly to the screen during use.

@ Since ultrasonic is used to detect the position of the Electronic Pen and Electronic
Eraser when they are being used, you may hear a buzzing sound, but this is not
harmful to the human body or peripheral hardware.

It will also not result in an electric shock.




Precautions

Battery If batteries are used improperly, batteries may leak, causing corrosion of the
product, or they may burst. To prevent this, always follow the precautions given
below.
® Always remove batteries from the Electronic Pen and Electronic Eraser if they are

not to be used for an extended period of time.

® Use the same type of batteries. Do not mix different types.

® Do not mix old and new batteries.

® Always insert batteries with their polarity properly oriented as indicated on the
Electronic Pen or Electronic Eraser.

@ |f the Electronic Pen or Electronic Eraser ceases to function because batteries
have run out, remove them immediately and dispose of them according to local
regulations.

Leaving drained batteries in the Electronic Pen or Electronic Eraser may result in
leakage.

® Do not disassemble batteries or place them in a fire.

@® Do not short batteries.

@ Alkaline batteries cannot be recharged. Never attempt to recharge alkaline
batteries.

Projector @ Light from the projector may enter the eye when using a projector to project

images for the purpose of making presentations and so on. Be very careful as
direct projector light may hurt the eyes.

09)
D
—h
o
-
D
<
o
c
(]
—
Q
=

11



12

Part Names and Fu

nctions

Electronic Pen/Electronic
Eraser Position Receiver —

Power Switch

Output Port

Outputs copy paper that
has been copied. Can hold
up to 20 sheets.

Paper Cover
Open this cover when loading
copy paper.

Printer Door

Open the printer door when loading
transfer film or when removing
paper jams.

(See pages 14, 20 and 21..)

Control Panel

S Electronic Pen/Electronic
Eraser Position Receiver

Screen Film

AC Inlet

Tray
\ Interactive Connector
Power Cord

Printer Open Lever

Push down this lever to open
the printer door.

@ Contrast/Remaining Film
Indicator |

(5) Multi-Copy/Error Indicator
|—® Advance Key

Panasonic kx-psoo .OI II‘ :Ib/el ! I’

@ Contrast Key
(3) 2-Screen Copy Key

|—@ Copy Key

(6 Multi-Copy/Stop Key

Electronic Pen (See page 24)

Pen Button*

Pen Holder Lever

*When using the projector mode to operate the
computer screen on the print board screen and
operating the pen while holding down the pen
button achieves the same function as pressing
the right mouse button.

Electronic Eraser (See page 25)

Eraser Cover —_I

Eraser Cloth



Part Names and Functions

m The control panel

Name Panel Description

This lamp indicator notifies the user when the time to replace the thermal

transfer film is approaching (estimated) and of the printing contrast used

during copying.

Indicator off : Normal printing contrast.

@ Contrast/ Indicator on : Darker than normal printing contrast.
Remaining Indicator flashing : = Almost time to replace the thermal transfer film.
Film (Note that only about 15 more sheets may be copied when
Indicator this indicator starts flashing.)
Replacement film (KX-BP081 or KX-BP082) is separately
available from the dealer where you purchased your unit.

*The flashing indicator will go out after the power is turned off and the printer
has been opened and closed. (When copying is performed, this indicator will
begin flashing again.)

@Contrast @ Each time this key is pressed, the unit will alternate between normal and
Key dark contrast modes (Normal/Dark).
®2-Screen I:I This key causes the front and back of the screen to be copied on a single
Copy Key sheet of paper.
@Copy Key| () |This key prints a copy of the screen.
®Multi This indicator displays the number of copies to be made. The display
Cu "/ changes each time the multi-copy/stop key is pressed.
EOpy Example 152 & -9 o1 — -
| répr t When an error occurs, a flashing symbol will appear in this display to indicate the error
hdicator status. (See page 69.)
When making multiple copies, press this key until the desired number of
® , copies is displayed on the multi-copy/error indicator. This key can also be
Multi- E pressed while multiple copies are being made to stop the copying
Copy/ process. The display indication changes while multiple copies are being
Stop Key made as shown below. After reaching 0, the display will reset to 1.
Example:5 -4 -3 -2 -1 - 0 - 1 (countdown display during copying)
@Qg)\//ance D This key advances the screen from right to left.
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Installing Thermal Transfer Film

Load the thermal transfer film into the film cassette and install in the printer.

1 Set the power switch to on (| ).

@" " " will flash on the multi-copy/error indicator
when the thermal transfer film has run out.

2 Push down the printer open lever and open the
printer door.

3 Insert the four gears into the new thermal
transfer film.

® Securely align the gear tabs with the grooves in
the thermal transfer film and insert them as far
as they will go.

®There is a blue gear and three green gears
which need to be attached as shown in the
figure on the right.

ON

d

Power Switch

OFF

\\
= ‘ — .
\l\?ﬁ N 5:)

A2
(=2

=74\
\’

Printer Door

Gear Tabs Grooves
77/ (Blue)
%\ .
X X
'I_'herm al
Transfer Film

Green Gear ~

o

b

Ny
YA

Green Gears

Green Gear




Installing Thermal Transfer Film

Load the thermal transfer film into the film

cassette. Blue Label  Thermal
Transfer Film

®Load the thermal transfer film into the film
cassette so that the blue gear inserted in the Load thermal transfer
thermal transfer film is located on the blue label film in this derection

side of the film cassette. Push in the direction
of the arrow until you hear all four gear shafts
click in place.

If the thermal transfer film is slack, take up the
slack by winding the gears on the label side of
the cassette in the direction of the arrows.

® The multi-copy/error indicator may flash
"7 »if the thermal transfer film is slack.
In addition, the thermal transfer film may
wrinkle, and blank (unprinted) spots or black
streaks may appear on the copy paper.

Install the film cassette.

®Insert the film cassette into the printer so that
the blue gear on the cassette aligns with the
blue label on the printer and then insert the
gear shafts on both sides of the cassette into
the grooves inside the printer.

@ |f the film is slack after loading the film
cassette, take up the slack in the same manner
described in step 5 while the cassette remains
loaded.

Grooves

Close the printer door.
® Securely close the printer door by using both
hands until a click is heard.
®The" ' " flashing on the multi-copy/error
indicator will go out.

®|f the flashing " ™ " does not go out even
though the printer door has been closed, this
indicates that the film cassette has not been
installed properly or that there is slack in the
thermal transfer film. Check the condition of the
film cassette and for slack in the thermal
transfer film.

15
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Loading Copy Paper

It is possible to load up to 80 sheets of Letter size copy paper [assuming a paper weight of 80g/m? (21 Ibs)].
Note that only Letter paper may be used.

When the unit is first used or when " - " flashes on the multi-copy/error indicator to indicate that the unit is out of
paper, load copy paper as described below.

g
Notes on Loading Copy Paper
Follow the guidelines below to ensure smooth and accurate printing by the unit.
® Only use Letter size copying paper having a weight of 60 to 90g/m* (16 to 24 Ibs) as the copy paper for
this unit.
® Do not simultaneously load paper of varying type and thickness as this may result in paper jams.
@ Before adding copy paper, be sure to remove all copy paper remaining inside the unit's paper cover.
(Note : That copy paper will slightly resist being removed, but may be pulled out without problems.)
After removing the copy paper, stack the removed paper together with the new paper, fan it thoroughly,
square it and reload.
DO NOT USE THE FOLLOWING TYPES OF PAPER
@ Extremely smooth or glossy paper
@ Coated paper
® Thermal paper
@ Paper that is printed on one side
@ Wrinkled paper, creased paper, etc.
N

1 Set the power switch to on (| ).

@®" - " will flash on the multi-copy/error indicator

when copy paper has run out.

|

®Be absolutely sure to check that the power is a

on when loading copy paper as it will not load
properly otherwise.
Power Switch

ON

OFF




Loading Copy Paper

Pull the paper cover forward as shown in the
right figure.

® The magnets are used as fasteners to hold the
paper cover closed.

To prevent paper jams such as those caused
by multiple sheets feeding, once fan the paper
thoroughly, square it, align it with the guide
inside, and insert as far as it will go.

®Only use Letter size copying paper having a
weight of 60 to 90g/m2 (16 to 24 Ibs) as the copy
paper for this unit.

® Do not stack more copy paper in the unit than
the maximum paper limit indicated by the guide
(see figure to the right) as this may result in
paper jams. [The unit can hold about 80 sheets
of paper having a weight of 80g/m? (21 Ibs).]

Close the paper cover.

Magnets

Paper Cover

17



Making Copies

This section describes how to copy text and illustrations drawn on the screen.

1 Set the power switch to on (| ).

®"1" will light on the multi-copy/error indicator to
indicate that the unit is ready to copy.

2 Press the copy key ().

® Text and illustrations on the screen will be
copied and copies emerge from the output port.

® The output port can hold up to 20 sheets of
copy paper. (Note that exceeding the output
port's capacity may result in paper jams.)

® For details on making multiple copies,
2-screen copies and so on, see page 19.

® Do not use paper that has been copied on one
side by this printer as copy paper in this unit or
in any other copiers or printers as this may
result in dirty rollers, degradation of printing
quality, paper jams, and streaks and smudges
on output paper.

® Copy quality increases with the thickness of
the drawn line. To ensure quality copies,
please use the markers (Big).

® The markers for interactive (Small) draw thin
lines. The quality of the copies may be reduced
when these markers are used.

18
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Making Copies

m Copy types and procedures

Copy Type

Procedure

Copying the front
of the screen

Press (:) :

Copying the back
of the screen

@ Press ) ) to move the screen to be copied to the front.

@ press ().

Making multiple
copies (up to 9)

@ Select the number of copies (1 to 9) by pressing as necessary.

@ Press ().

® Press to stop copying in mid-operation.

Making 2-screen

copies

® Copying the front and
back of the screen on a
single sheet of paper

Press |:| :

2-Screen Copy

..........................

Copying chart
paper

Chart paper can be attached to the screen as shown in the figure and
copied. (Be sure to take the chart off the screen soon after copying is
finished.)

Attach both
4— sides with —»|

® \Wrinkles, slackness or folds in the chart when attached to the screen will show up
in copies as dark shadows.

@ Affix it to the screen with drafting tape made by 3M® or other similar tape with
medium adhesive.

3M@® s a registered trademark of 3M Corporation.

19
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Replacing Thermal Transfer Film

The unit is capable of producing about 15 more copies when the contrast/remaining film indicator begins to flash.
The unit has run out of thermal transfer film and can no longer make copies when the multi-copy/error indicator
flashes " I” ". Separately available replacement film (KX-BP081 or KX-BP082) may be purchased from the dealer
where you purchased the unit. Thermal transfer film is replaced as follows.

e A
Notes on Replacing Thermal Transfer Film
® Only use the designated product (KX-BP081 or KX-BP082) from Panasonic as the replacement
film. (Note that using another type of replacement film may result in degraded printing quality or
damage to the unit.)
® Thermal transfer film is disposable. Dispose of used thermal transfer film as "burnable" or "non-
recyclable" rubbish.
@ A negative of the copied image will remain on the thermal transfer film. To protect the security of
your information, we recommend cutting up used thermal transfer film with scissors or shredder
before disposing of it.
N J

1 Push down the printer open lever to open the
printer door, and remove the film cassette with
both hands.

2 Remove the used thermal transfer film from
the film cassette and remove the four gears.

3 Next, perform steps 3 to 7 in the section
entitled "Installing Thermal Transfer Film" that
can be found on page 14 and 15.

2y Direction for
_)Removing
Thermal
Transfer Film

\
{

Green Gear @
I | S
G-

Thermal
Transfer Film

Green Gears




Paper Jams

Remove paper jams by the following procedure when copy paper does not come out of the output port or when ", | "
flashes on the multi-copy/error indicator.

1

2

3

4

Push down the printer open lever to open the
printer door.

Remove the film cassette with both hands.

Remove all jammed paper.

If the thermal transfer film is slack, take up the
slack by winding the gears on the label side of
the cassette in the direction of the arrows.

® The multi-copy/error indicator may flash
"7 " if the thermal transfer film is slack.
In addition, the thermal transfer film may
wrinkle, and blank (unprinted) spots or black
streaks may appear on the copy paper.

Slack Prohibited

Thermal
Transfer Film

21
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Paper Jams

5

Install the film cassette.

®Insert the film cassette into the printer so that
the blue gear on the cassette aligns with the
blue label on the printer and then insert the
gear shafts on both sides of the cassette into
the grooves inside the printer.

Close the printer door.

® Securely close the printer door with both hands
until a click is heard.

®The" ,{ " flashing on the multi-copy/error
indicator will go out.

Grooves

Grooves

=UE

®|If the flashing ",/ " does not go out after the foregoing procedure has been performed;

This may indicate that the paper feeder is not functioning properly.

Reload the copy paper by following the steps given below.

1

2

Turn the power off and on.

Open the paper cover and remove all copy
paper remaining inside the unit's paper cover.
® Note that the copy paper will slightly resist

being removed, but may be pulled out without
problems.

Paper Cover




Paper Jams

3 To prevent paper jams such as those caused
by multiple sheets feeding, once fan the paper
thoroughly, square it, align it with the guide
inside, and insert as far as it will go.

® Do not stack more copy paper in the unit than
the maximum paper limit indicated by the guide
(see figure to the right) as this may result in
paper jams. [Note that the unit can hold about
80 sheets of paper having a weight of 80g/m?
(21 1bs).]

J

4 Close the paper cover.

Paper Cover

23



Before Using the Interactive Function

m Setting the Electronic Pen

1 Remove the battery cover on the pen holder,
insert the batteries as shown in the figure to
the right, and re-attach the battery cover.

® Always use “AAA” size (alkaline) batteries and
be sure that their polarity is properly oriented.

® Do not mix old and new, different type batteries
when replacing batteries.

2 Remove the temporal cap, and set the cap and
adaptor to the marker for interactive.

® Securely push the adaptor into the maker for
interactive as far as it will go.

® Do not remove the color identification cap on
the back end of the marker.

3 Rotate the pen holder lever to the release
position, insert the marker for interactive, and
then return the pen holder lever to the lock
position.

®Lock the pen holder lever while inserting the
marker all the way into the pen holder until you
hear a buzzing sound.
Detection of the marker color may not work well
unless the marker is inserted fully into the pen
holder.

® Do not set the marker near the electronic print
board while using the interactive function as
this may appear unnecessary streaks not
written on the computer screen.

Battery
Cover

o

\\v

% 12 >
o O
(©)

//\ Pen Holder

Marker for Interactive
Remove the

temporal cap.

Color
Identification Cap

Adaptor
Cap ,

v

® Inserting _
> }\3%5'“9
@Releasing
/ /
Marker for Pen Holder
Interactive Lever

\ 4

2 ~3mm (3/32" ~4/32" )

® Press down firmly with the point of the Electronic Pen on the screen film until you hear a buzzing sound.
@ For precise positioning, keep the Electronic Pen perpendicularly to the screen during use. Inclined pen angle will

cause the shift of position.
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Before Using the Interactive Function

m Setting the Electronic Eraser

Remove the eraser cover, insert the batteries as
shown in the figure to the right, and re-attach the
eraser cover.

® Always use “AAA" size (alkaline) batteries and be
sure that their polarity is properly oriented.

® Do not mix old and new, different type batteries
when replacing batteries.

m Replacing the eraser cloth

1 Remove the eraser cloth by pushing through
the hole in the Electronic Eraser. O\Tiress —

Hole ———a—-"">

Eraser Cloth

2 Attach a new eraser cloth by pressing around
the edge.

® Press down firmly with the eraser cloth of the Electronic Eraser on the screen film until you hear a buzzing sound.

25
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Before Using the Interactive Function

m System requirements

Computer: IBM® PC/AT or compatible machine with CD-ROM drive

CPU: Pentium® 150MHz or higher processor

Port: 9-pin communication (COM) port

Operating System: Windows® 95, Windows® 98, Windows® Millennium Edition,
Windows NT® 4.0 or Windows® 2000

Memory: 32MB or higher

Hard Disk Space: At least 10MB free space

m Connecting to the PC

1 Connect one end of the proprietary interactive
cable supplied to the interactive connector
under the tray and the other end to the
computer's communication (COM) port.

Interactive Board

)
00000
e 0000 e

®Be sure to turn off the electronic print board
and PC before you connect or take off the

interactive cable. N =
4
2 After connecting the interactive cable, securely s
tighten the screws on the connector. Interactive Cabm& Interactive
Connector

To the PC

Note (communication port)

This cable is a proprietary interactive cable for
connecting the electronic print board with

a PC.

Please do not use it with any other products.




Before Using the Interactive Function

m Installing the software

In order to use interactive functions by connecting a computer and the Interactive Panaboard CD
Interactive Panaboard, it is necessary to install the Interactive
Panaboard Software.

When you insert the CD-ROM into the CD-ROM drive, the Installation
Software will run *automatically. This will display the software menu on
the right. This menu consists of two sub menus;

Manuals
®Readme - You can view the readme file Installation
® Operating Instruction — **You can view the Operating Instruction
Man Ual, Readme Interactive Panaboard
Operating Instruction
Applications Aerobat (R) Reader

@ Interactive Panaboard — This install the software needed for the
Interactive Panaboard.

*Depending on the Operating System or the settings that you are using, the Automatic Installation Software may
not work. If this is the case please run the Installation Software "cdrun.exe" in the CD-ROM through Windows
Explorer.

**|nstall Acrobat Reader 4.0 — Acrobat Reader is needed in order to view the Operating Instruction Manual.

@®Installing the Interactive Panaboard Software

(1) Click “Interactive Panaboard” from software menu.

@®|nstallation of the Interactive Panaboard Software will start.

(2) Follow the instructions on the screen to complete the installation.

®\When the installation of the Interactive Panaboard Software is completed, “Interactive Panaboard”
group will be entered under “Panasonic” at the Program menu.
Under the “Interactive Panaboard” group, there will be three items, Interactive Panaboard
Software, Help and Operating Instructions.

®Adobe® Acrobat® Reader is necessary to refer to the Operating Instructions.

Remark:

® Uninstalling the software
If you need to uninstall the Interactive Panaboard Software, please follow the following procedure.

(1) Click the [Start] button, and then click "Control Panel" in "Settings".

(2) Double-click "Add/Remove Programs" icon in the Control Panel.

(3) Select "Interactive Panaboard" in the Add/Remove Programs list, and click [Add/Remove] button.
(4) Follow the instructions on the screen to complete the uninstall.

27



28

Before Using the Interactive Function

@®In order to view the Operating Instruction Manual on the CD ROM, Reference of the
Interactive Panaboard Operating Instructions in CD-ROM

©® Adobe® Acrobat® Reader is necessary to refer to the Operating Instructions.
If it is not installed on your computer, install Adobe® Acrobat® Reader before refer to the Operating
Instructions.

(1) Click "Operating Instructions" in Manuals group of the Automatic Installation Software.

(2) You can see the Operating Instructions after Adobe® Acrobat® Reader runs automatically.

eInstalling Adobe® Acrobat® Reader
(1) Click "Acrobat (R) Reader" in Manuals group of the Automatic Installation Software.

@ Installation of Adobe® Acrobat® Reader will start.

(2) Follow the instructions on the screen to complete the installation.



Using the Interactive Panaboard Software

m Start up the Interactive Panaboard Software

1
2

4
5

Turn on the power of the Interactive Panaboard.

Turn on the computer's power and start up Windows.

Click the [Start] button, and then click [Programs] - [Panasonic] -
[Interactive Panaboard] - [Interactive Panaboard]. & hteractive Panaboard s detected at GOMI.

® The Interactive Panaboard Software runs, and the COM detection

dialog box appears to show the Interactive Panaboard is detected.

Click the [OK] button. T
gl Cancel I

® The Select Mode dialog box will appear.

Projector  Whiteboard

Click either the [Projector] button or the [Whiteboard] button, and
then click the [OK] button.

When the Projector mode is selected:

The calibration start screen will be displayed, then calibrate to adjust the position of the projected image and the
position of the Interactive Panaboard screen.

When the calibration is completed and the Projector mode become active, the icon will be registered in the
Taskbar and the Desktop Drawing Tool will appear automatically.

@ In the Projector mode, the Desktop Drawing Tool is used for operation.

The View window is used for playback and for editing a file which is recorded in the Projector mode.
For operation of the Projector mode, refer to "Projector Mode" from page 32.

When the Whiteboard mode is selected:
The icon will be registered in the Taskbar and the Whiteboard window will appear automatically.

@ In the Whiteboard mode, the contents of the drawing on the Interactive Panaboard Screen will be displayed in the

Whiteboard window.
The Whiteboard window is also used to playback and to edit a file which is recorded in the Whiteboard mode.
For operation of the Whiteboard mode, refer to "Whiteboard Mode" from page 43.

Remark:
@ If the Interactive Panaboard is not detected, the confirmation dialog box
appears. & Interactive Panaboard was not detected at COM1 .
Select Setting button to change COM port.

In this case, check the condition of the Interactive Panaboard, the connection
of the Interactive Cable or the communication port setting.

gety | omine |

To change the communication port setting, click [Setting...] button. (Refer to
page 30 "COM Port".)
@ If the Interactive Panaboard Software is used without connecting the Interactive Panaboard, click [Offline] button
in the connecting confirmation dialog box.
In the offline state, a file recorded in the Projector mode or the Whiteboard mode can be played back and edited.
® The tool tip text displayed when the mouse is located over the icon in the Taskbar allows you to determine
the current mode.
Projector mode: "Interactive Panaboard (Projector)"
Whiteboard mode: “Interactive Panaboard (Whiteboard)"
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Using the Interactive Panaboard Software

m Pop-up menu configuration of the Interactive Panaboard Software

Right-click the in the Taskbar to get the pop-up menu.
Following operations are possible in the pop-up menu.

Select Mode... : Allow you to switch between modes (Projector mode/ Whiteboard mode).
Calibrate : Execute the calibration. (Projector mode only) [0 Page 33
Tool Draw : Display the Desktop Drawing Tool. (Projector mode only) [0 Page 36

_|: View Window : Display the View window. (Projector mode only) [0 Page 42
Open/Close

Whiteboard window : Switch the Whiteboard window open/close. (Whiteboard mode only) [0 Page 45
Settings COM Port...: Set the communication port.

Adjustment... : Adjust the position of the Electronic Pen or the Electronic Eraser to
improve the shifted position.

Options... : Set the option of the Interactive Panaboard Software.
Help Topics... : Display the help of the Interactive Panaboard Software.
About... : Display the Interactive Panaboard Software version information.
Exit : Exit the Interactive Panaboard Software.

m Switching the mode

You can freely switch the Projector mode and the Whiteboard mode while the Select Mode [X]
Interactive Panaboard Software is running. Mode

% Cancel
1 Right-click the icon in the Taskbar and click [Select Mode...] in  piectsr whteboars  cancel_|

the pop-up menu. In addition, you can double-click the icon in
the Taskbar.

® The Select Mode dialog box will appear.

Click either the [Projector] button or the [Whiteboard] button, and then click the [OK] button.

®\When switching to the Projector mode, the calibration screen will not be displayed automatically
after calibration ended correctly once. Please calibrate if necessary.
®\When switching to the Whiteboard mode, the Whiteboard window will be displayed.

m Settings of the Interactive Panaboard Software
® COM port
Setup the communication port to communicate with the Interactive Panaboard. COM Port

(1) Right-click the icon in the Taskbar and click [Settings] - [COM eonror foom 3]
port...] in the pop-up menu. Mo Detection: __ gtart., _ |

® The COM port dialog box will appear. R cancer |

(2) Click the [Start...] button of the Auto Detection to detect the communication port
connected with the Interactive Panaboard automatically.
Otherwise, click the arrow at the bottom on the right side of the [COM port] box and then
click the communication port from the list.

(3) Click the [OK] button.



Using the Interactive Panaboard Software

® Adjustment
The Electronic Pen or the Electronic Eraser position may largely shift by the [Adiustnent x
using environment. In this case, adjust the position according to the following P B D R S e SEEa Ci
. . - drag the electronic pen downward about 100mm (4"}
pI’OCEdUI’eS tO Impl’OVG the Shlfted pOSItIOI’l *For precise adjustment, keep the electranic pen perpendiculary.
(1) Right-click the icon [ in the Taskbar and click [Settings] - o

[Adjustment...] in the pop-up menu.
@®The Adjustment dialog box will appear.

(2) Place the Electronic Pen at the center of the Interactive
Panaboard screen and drag slowly the Electronic Pen
downward about 100mm (4").

@®\When the adjustment is finished, the adjustment end message will be displayed in the Adjustment
dialog box and the [Cancel] button will be changed into the [OK] button.

(3) Click the [OK] button.

@ For precise adjusting, keep the Electronic Pen perpendicularly to the Interactive Panaboard screen during the
adjustment. Inclined pen angle will cause the shift of position.
® To cancel the adjustment, click the [Cancel] button by a mouse of the computer.

®Options
Set-up the option of the Interactive Panaboard Software.
1 - H 1 1 H W Show Desktop Drawing Tool when Projector Mode starts
(1) nght C“Ck the Icon n the TaSkbar and CIICk ¥ Erint out image autormatically rotates to fit printer paper direction Cancel

[Settings] - [Options...] in the pop-up menu.
®The Options dialog box will appear.

(2) The following options can be set.

Show Desktop Drawing Tool when Projector Mode starts:
When this is selected, the Desktop Drawing Tool is automatically displayed after the Projector mode
starts.

Print out image automatically rotates to fit printer paper direction:
When this is selected, the printing image automatically rotates to fit the direction of paper set in a printer.

(3) Click the [OK] button.

m Reference the help
Right-click the icon in the Taskbar and click [Help Topics...] in the pop-up menu.

@ The topics on the online help are displayed.

m Display the information about the Interactive Panaboard Software
Right-click the icon in the Taskbar and click [About...] in the pop-up menu.

® The version information of the Interactive Panaboard Software is displayed.

m Exiting the Interactive Panaboard Software
Right-click the icon in the Taskbar and click [Exit] in the pop-up menu.

® The Interactive Panaboard Software ends. 31



Projector Mode

m Precautions when using a projector

Position Receiver

Electronic Print Board

Interactive Upper Position Receiver

Limit Mark

Interactive

100mm (13/8"
( ) Upper Limit Mark

35mm 4
(13/8") 100mm (13/s")
~—_35mm
(23/8")
Screen Film
Projector g

/

* Do not use the shaded area.

®\When using a projector to project images, be sure to display the image so that it is centered left-to-right
on the electronic print board screen and with at least a 50 mm (2") gap between the top of the image
and the screen border. Note that the Electronic Pen does not always operate properly when within 50
mm (2") of the top of the screen, 100 mm (3**/,,") of the position receiver and 35 mm (1%/,") from the both
sides of the screen.

@ Since the Electronic Pen position may shift if the image on the screen is trapezoidal, adjust the projector
so that the image on the screen is rectangular.

® \When projecting an image on the electronic print board using a projector, the image on the screen may
become difficult to see depending on the viewing angle and position due to reflected projector light.
If this happens, adjust the location of the projector or change your viewing position.

@ \When using a projector to project a PC screen, be sure to use optimum resolution settings for the
projector and the PC. The image may be difficult to see if optimum settings are not used. Fine lines in
the image on the electronic print board screen may appear broken particularly if the projector resolution
is lower than the PC resolution.

® \When using a projector to project images, the Electronic Pen position may shift if the projection position
shifts due to the following causes. If this happens, it becomes necessary to perform calibration to re-
position the projected image on the screen. (For details on calibration, please see page 33.)

e\When the installed location of the projector is changed.
«\When the position of the electronic print board is changed.
¢ \When the projection area and position has changed due to using a projector function such as zoom.
«When the display resolution of the projector or PC has changed.
Note that the position of an electronic print board attached to a stand may shift if it is struck carelessly.
Always make sure the stand's casters are locked in place.
@ Light from the projector may enter the eye when using a projector to project images for the purpose of
making presentations and so on. Be very careful as direct projector light may hurt the eyes.



Projector Mode

m Basic operation flow in Projector mode

This section explains the flow of basic operations when using the Interactive Panaboard Software in the Projector
mode. We recommend trying the operations in accordance with the following steps to help you completely
understand the operations in the Projector mode.

@ For any explanations on the operations of the Projector mode, the Electronic Pen will be referred to as "Mouse"
and the projected computer screen on the Interactive Panaboard will be referred to as "Desktop".

@ Calibration
Calibration is an operation to calibrate the
position of the computer screen projected onto @
the Interactive Panaboard screen to judge the

position by the Interactive Panaboard Software. Place th?
Electronic Pen

(1) Start the Interactive Panaboard on this position Calibration
Software and select the Projector and depress it.
mode. (See page 29.)

® The calibration screen is displayed. @

(2) In the sequence of upper left, upper

right, lower right and lower left, press for about two seconds for center of each four corner
position with the Electronic Pen.

®\When this operation ended correctly, then the next position starts automatically.

(3) When the calibration ended correctly, there is a message telling you its finish. From this
point onward, the Electronic Pen can be used as the Mouse.

@ If you move the projector or Interactive Panaboard, the position of the computer screen projected onto the
Interactive Panaboard screen will be changed. This will result in out of position of the Electronic Pen. If this
happens, you will need to recalibrate the unit by executing [Calibrate] in the pop-up menu.

@ In the Projector mode, use the Electronic Pen with its cap on.

® Do not cover the position receiver with your hand as this may cause interactive function to stop functioning.

® Press down firmly with the point of the Electronic Pen on the screen film until you hear a buzzing sound.

@ For precise positioning, keep the Electronic Pen perpendicularly to the Interactive Panaboard screen during
use. Inclined pen angle will cause the shift of position.

Remark:

@ If recalibration is necessary, click [Calibrate] in the pop-up menu.
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Projector Mode

@ Use the Electronic Pen as a mouse
After the calibration is completed, the Electronic Pen can be used as a mouse for the projected computer screen
on the Interactive Panaboard.

(1) If the Desktop Drawing Tool is not displayed, right-click the icon in the Taskbar
and click [Tool] - [Draw] to display the Desktop Drawing Tool.

Operations of "click” and "drag" are as follows.
@ Single click: Press the projected screen with the tip of the Electronic Pen.

® Double-click:  Double-click is executed by performing two quick clicks at the same position with
the tip of the Electronic Pen.

e
(2) To use the Electronic Pen as a mouse, click [53| (Arrow) in the Desktop Drawing Tool. é
o
b
Izl

®Drag: Press and hold the desire image with the tip of the Electronic Pen while dragging E
the image to its new position.

@ Right-click: Locate light gray button on the Electronic Pen. While pressing the button of the
Electronic Pen, press the projected screen with the tip of the Electronic Pen and
release. (Do not release the button of the Electronic Pen before all of these
operations are finished.)

For more details about the Desktop Drawing Tools, please refer to "About Desktop E
Drawing Tool" from page 36.

@ For precise positioning, keep the Electronic Pen perpendicularly to the Interactive Panaboard screen
during use. Inclined pen angle will cause the shift of position.

& |8 |

Remark:

[ |& sl |

@ If double-click does not work properly, confirm that the same position is accurately clicked twice.
When the position is different, it is not recognized a double click.
Or, try different timing of depressing and releasing of the Electronic Pen. This operation is also depending on
the setting of the double-click speed of the [Control Panel].

® Draw and erase handwritten lines on the Desktop

(1) Click either (Black, Red, Blue or Green Marker) in the Desktop Drawing Tool to
draw handwritten lines.

® The shape of the mouse cursor changes to ﬁh

(2) Position the mouse pointer where you want to draw a handwritten line on the
Desktop and drag the Mouse.

(3) Click (Eraser) in the Desktop Drawing Tool to erase the handwritten line.

® The shape of the mouse cursor changes to Y

(4) Drag the Mouse to the area on the Desktop to be erased.

Remark:

® The width and color of the markers and the size of the eraser can be changed. (See page 38.)



Projector Mode

® Record image and handwritten lines data on the Desktop

Data of handwritten lines drawn or erased on the Desktop using the Desktop Drawing Tool can be recorded in
Interactive Panaboard format files (extension ".ipb", referred to as IPB documents) along with the initial Desktop
image.

Written or erased handwritten lines are recorded in stroke units and can be displayed, played back and edited
later in the View window.

(1) Click [®] (REC Start) in the Desktop Drawing Tool.

@ |f there are drawn lines on the Desktop, a verification dialog box will appear to confirm whether to
erase drawings.
To erase the drawn lines and start recording, click [Yes] button.
To leave the drawn lines and start recording, click [No] button. In this case, drawn lines become a
part of background image.

® The image of the Desktop is displayed in the dialog box.

(2) If it is acceptable to store as a background image, click the [OK] button.

(3) Draw lines by using (Black, Red, Blue or Green Marker) or erase drawn line by
(Eraser) in the Desktop Drawing Tool.

(4) After finishing your drawing and erasing, click [®] (REC Stop) in the Desktop Drawing Tool.
® The recording image will be displayed in a dialog box.

(5) Click the [OK] button to record the recording image.
® The Save As dialog box will appear.

(6) Enter the folder where you want to save the file and the file name.

® The extension of the file is ".ipb".

(7) Click the [Save] button.

® Do not change the Desktop resolution while recording data. If changed, the Desktop image will not be
displayed properly when it is displayed in the View window.

Remark:

® More than one page can be recorded. (See page 40.)

®Playback the recorded data by View window
Desktop background data and handwritten lines data stored using the Desktop Drawing Tool can be displayed
in the View window as well as browsed, played back and edited.

(1) If the View window is not displayed, right-click the icon in %?‘TH "
the Taskbar and click [Tool] - [View Window] to display the ATIYEE]
View window.

(2) Click [Open...] in the [File] menu.
® The Open dialog box will appear.

(3) Enter the folder to look in and the file name you want to open.

® The file has an ".ipb" extension.

(4) Click the [Open] button. 35



Projector Mode

Remark:

® Many different operations can be executed in the displayed IPB document.
Save the IPB document in another file format. (See page 50.)
Switch a page of the IPB document. (See page 54.)
Edit a page of the IPB document. (See page 54.)
Playback the IPB document. (See page 57.)
Print the IPB document. (See page 58.)

m About Desktop Drawing Tool

The Desktop Drawing Tool is a tool for drawing, erasing, recording, etc. on the Desktop.

In the Projector mode, click [Tool] - [Draw] in the pop-up menu. The Desktop Drawing Tool will be appeared
when there is a check mark. While the Desktop Drawing Tool is being displayed, click [Tool] - [Draw] in the
pop-up menu. This will delete the check mark and the Desktop Drawing Tool will disappear.

The Desktop Drawing Tool is always displayed at the front of the Desktop. From this Desktop Drawing
Tool, the tools can be selected for drawing or erasing lines.

The data drawn on the Desktop can be stored into the IPB document together with the desktop image.
They can be displayed or edited by the View window.

In the Desktop Drawing Tool, following tools can be used.

® The standard display condition

1 |@ == =0 @8 1 R e lelele T

Arrow: Use the electronic pen as the Mouse.

Black Marker: By dragging the Mouse, black line can be drawn.

Red Marker: By dragging the Mouse, red line can be drawn.

Blue Marker: By dragging the Mouse, blue line can be drawn.

Green Marker: By dragging the Mouse, green line can be drawn.

Eraser: By dragging the Mouse, lines can be erased.

Setting: The width, color of the markers and size of the eraser can be changed.
All Clear: Clear all drawn lines.

Capture: Output the Desktop image as an image file.

Print: Print out the Desktop image.

White Background: Change the background of the Desktop to the whiteboard.
Click once again will release the Whiteboard status.

Refresh: All of the drawn lines on the Desktop are re-displayed.

El REC Start: Start recording of the data.
The capture image of the Desktop is added as an initial data.
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E REC Stop: Stop recording and store the recording data.

E Page No.: Display the page number which is being recorded.
Before recording, it is (0). When the Recording start button is depressed, it
displays as (1), and following pages will be numbered accordingly.

5| New Page: Saves current page recordings and starts the process to record the next page.
Selecting this icon will stop the recording of the current page. The recording
process will be paused while the current page is saved and the background for
the next page is changed and confirmed.
To start the recording process of the next page, select the E| (REC Start)

icon.
Minimum: Shrink the size of the Desktop Drawing Tool.

@ Shrunken display condition |
Selected tool: Display the current selected tool. I%
Maximum; Return to the standard display condition of the Desktop Drawing Tool. g

Remark:

® When the Desktop Drawing Tool is closed, the drawings are erased.

m Desktop Drawing Tool operation

® Draw and erase handwritten lines

(1) Click either (Black Marker, Red Marker, Blue Marker or Green Marker) in the Desktop
Drawing Tool.

® The shape of the mouse cursor changes to @ .

(2) Position the Mouse where you want to draw a handwritten line on the Desktop and drag
the Mouse.

(3) Click (Eraser) in the Desktop Drawing Tool.

® The shape of the mouse cursor changes to Ny

(4) Drag the Mouse to the area on the Desktop to be erased.

Remark:

® The width and color of the markers and the size of the eraser can be changed. (See page 38.)
® Handwritten lines drawn on the Desktop may be hidden or shifted when an application or a window are
operated. If this occurs, click (Refresh) to redisplay the Desktop.
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® Change Marker/Eraser settings

Change the width and color of the markers and the size of the
eraser used in the Desktop Drawing Tool.

The marker width and color can be changed for four marker
colors.

(1) Click (Setting) in the Desktop Drawing Tool.
® The Marker/Eraser Setting dialog box will appear.

(2) To change the width of the markers, either enter a
width in [ 33w (Marker Width) at the right side

Marker /Eraser Setting

r~Marker YWidth and Color

Click to change color

—

~Eraser Radius

30 3: dots

O

i Ok I

Cancel |

Default |

of the marker whose width will be changed or click the up/down arrows on the right side to

set a desired width.

To change the color of the markers, click ——— (Marker Color) on the right side of the

marker whose color will be changed. The Color dialog box will appear. Click the color you
want to change from among Basic colors, and click the [OK] button.

To change the size of the eraser, either enter a size in | 4 wts (Eraser Radius) or click
the up/down arrows on the right side to set a desired size.

(3) Click the [OK] button.

(4) A dialog box will appear where you can select whether or not to apply the new settings to

handwritten lines drawn up to now.

Clicking [Yes] button will redraw the lines drawn up to that point using the new settings.
Clicking [No] button will only reflect the new settings for any subsequently drawn lines.

Remark:

® The marker width can be set in a range of 1 - 30 dots.

® Even though the marker colors are changed, the colors of the Desktop Drawing Tool buttons and the mouse

cursor will not change.
® The eraser radius can be set in a range of 1 - 60 dots.
® These settings are effective until being changed.

®Erase all handwritten lines on the Desktop

(2) Click (All Clear) in the Desktop Drawing Tool.

@ A verification dialog box will appear.

(2) Click the [OK] button to execute all clear.
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@ Save Desktop in image file
Save the background image of the Desktop and handwritten lines that were drawn on the Desktop as an image
file.

(1) Click (Capture) in the Desktop Drawing Tool.
@®The Save As dialog box will appear.

(2) Enter the folder where you want to save the file, the file name and the file type.
The following file formats can be selected for the [File type].
Bitmap Files (*.omp), TIFF Files (*.tif) or JPEG Files (*.jpg)

(3) Click the [Save] button.

®Print an image of the Desktop
Print the background image of the Desktop and handwritten lines that were drawn on the Desktop.

(1) Click (Print) in the Desktop Drawing Tool.
®The Print dialog box will appear.

(2) Set the [Printer] and [Number of copies].

(3) Click the [OK] button.

@®The Printing dialog box will appear.
@®To stop the printing, click the [Cancel] button in the Printing dialog box.

® Set the background of the Desktop to the Whiteboard
Allow you to make the background of the Desktop totally white.

(1) Click (White Background) in the Desktop Drawing Tool.

®In addition, click (White Background) again to return the background of the Desktop to its
original sate.

®Redisplay handwritten lines drawn on the Desktop
Handwritten lines drawn on the Desktop may be hidden or shifted when an application or a window are
operated. If this occurs, redisplay the Desktop.

(1) Click (Refresh) in the Desktop Drawing Tool.
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®Record drawing data in IPB document
Create an IPB document to record work performed on the Interactive Panaboard.
Clicking |E| (REC Start) in the Desktop Drawing Tool will record the Desktop image at that moment as a
background and any handwritten lines drawn or erased on the Desktop on a page in stroke units.
A page is a unit of recorded work performed on the Desktop. If (New Page) is used to add a page when
switching screens on the Desktop, the contents of the Desktop and the page can be synchronized.
The recording operation will stop when El (REC Stop) is clicked and the data saved as an IPB document.

(1) Click [#] (REC Start) in the Desktop Drawing Tool.

@If there are drawn lines on the desktop, a verification dialog box will appear to confirm whether to
erase drawings.
To erase the drawn lines and start recording, click [Yes] button.
To leave the drawn lines and start recording, click [No] button. In this case, drawn lines become a
part of background image.

®The image of the Desktop will be displayed in a dialog box.

(2) Click the [OK] button to store the data as the background image of the 1st page.

(3) Use the (Black Marker, Red Marker, Blue Marker or Green Marker) in the Desktop
Drawing Tool to draw handwritten lines.
In addition, use the (Eraser) to erase unwanted handwritten lines.
(4) Click [& (New Page) to add a page.
If no pages will be added, advance to step 11.
@®The recording image will be displayed in a dialog box.

(5) Click the [OK] button to record the recording image.
@ A verification dialog box will appear to confirm whether to erase the drawings.

(6) Click the [Yes] button to erase the drawings.
Or, click the [No] button to leave the drawings as a part of background image of a new
page.

@®The recording process is paused. The Electronic Pen cursor will automatically change to the
mouse arrow cursor, allowing the background image to be changed.
While the recording process is paused, all of the Desktop Drawing Tool icons are inactive except
the [ @] (REC Start) and (White Background) icons.

(7) Switch the Desktop to the desired background.

(8) Click [® (REC Start) to restart the recording of a new page.
@®The image of the Desktop will be displayed in a dialog box.

(9) Click the [OK] button to store the data as the background image of a new page.
@ All of the Desktop Drawing Tool icons will become active.

(10) To add multiple pages, repeat steps 3 to 9.

(11) Click [m| (REC Stop) in the Desktop Drawing Tool.
®The recording image will be displayed in a dialog box.

(12) Click the [OK] button to record the recording image.
@®The Save As dialog box will appear.

(13) Enter the folder where you want to save the file and the file name.
@ The extension of the file is ".ipb".

(14) Click the [Save] button.



Projector Mode

® Do not change the Desktop resolution while recording data. If changed, the Desktop image will not be
displayed properly in the View window.

Remark:

® While recording data, page numbers can be verified by (PageNo) in the Desktop Drawing Tool. Before
starting to record data, the data value is "0" and will change to "1" when |E| (REC Start) is clicked.
The value will then count up for each page break.

® When switching the computer screen being projected onto the screen of the Interactive Panaboard during a
meeting, begin drawing after adding (New Page) and recording the background image of the new page.

® A maximum of 50 pages can be stored.

®Reduce display size of the Desktop Drawing Tool
The Desktop Drawing Tool can be displayed at a reduced size.
When the screen is hidden by the Desktop Drawing Tool, executing this reduction in display size will allow you
to reduce the hidden portion to its minimum size.

(1) Click [&] (Minimum) in the Desktop Drawing Tool.
®Click (Maximum) to return the Desktop Drawing Tool to its normal display size.

Remark:

® Tools cannot be changed when displayed at a reduced size.
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m About View window

Desktop background data and data of handwritten lines recorded using the Desktop Drawing Tool can be
displayed in the View window as well as browsed, reproduced and edited.

In the View window, display and edit of the IPB documents which is recorded by the Desktop Drawing Tool are
possible.

In the Projector mode, click [Tool] - [View Window] in the pop-up menu to get the check mark, then the View
window will appear.

While displaying the View window, click [Tool] - [View Window] in the pop-up menu to delete the check mark, then
the View window will disappear.

D Title bar
0 Interactive Panaboard : View Window - [G¥Proeram Files¥Panasonic¥Interactive Panaboard¥Documents¥ProjectorMode.ipbl
File Edit Page/Play View Settines Help
@[Main] Toolbar——————= &= &z o
| S|
@)][Page/Play] Toolbar [ R
@[Markers/Eraser] Toolbar L VARKETTREND
Tooon} ) hi Y I e
L ) O S B
(@Main view — o) ~ e —
S \\ o ~EDUCATION
= TR
100000/ — 1* -r-l’*** i o0 ’ng
DQGEMSEQGB?SESSUDD‘\MD@MOEOS %
[ Jumitsc A4 Total Volume 3—¥ Average Price
. . = .k
@Thumbnail view = | | ==
@Status bar—ﬁéadv = = - [ I - 100K = 1024 x 768 pixels I Page 1 of 4 ;I
(®Replay mode @Image size (®Page number
@ Title bar: Indicate the currently opened file name of the IPB document.
(2 Main view: In the main view, the page to be edited is displayed.

When @ (Arrow) is selected in the [Markers/Eraser] Toolbar, a part of page can be copied
into the Clipboard by dragging the mouse. It can be copied to other application software by
drag and drop.

When marker is selected in the [Markers/Eraser] Toolbar, you can draw lines on the page. If
the eraser is selected, you can erase the lines.

3 Thumbnail view: The thumbnail image of the all pages of the IPB document can be displayed.
At the bottom of each page, the last modified date is displayed.
The image in the main view area is indicated as framing in the thumbnail area. To change
the editing page, click another page.

@ Toolbar: Toolbar has buttons which most frequently used functions are formed as icon.
It can be moved in the display area by dragging.
(® Status bar: Indicate the information of the IPB document.
(® Replay mode: Indicate if it is in the replaying or not.
@ Image size: Indicate the page size when it is 100% display ratio.

Page number: Indicate the total number of pages and the page being displayed.

For more details about the View window, refer to "View Window or Whiteboard Window Operation” from page 46.

42



Whiteboard Mode

m Basic operation flow in Whiteboard mode

This section explains the flow of basic operations when using the Interactive Panaboard Software in the
Whiteboard mode. We recommend trying the operations in accordance with the following steps to help you
completely understand the operations in the Whiteboard mode.

®Drawing and erasing handwritten lines on the Interactive Panaboard screen
When the Whiteboard window is displayed, set one of the four different types of the markers for interactive
(Small) used for the Electronic Pen, remove the cap and draw on the Interactive Panaboard. The content of the
drawing will be displayed on a page in the Whiteboard window in real-time. Further, if you use the Electronic
Eraser to erase the contents drawn on the screen, the handwritten lines displayed on the page in the
Whiteboard window will be erased as well.
These drawing and erasing operations are recorded automatically.

(1) Start the Interactive Panaboard Software and select the |z
: E e
Whiteboard mode. (See page 29.) LTI =

B

®The Whiteboard window is displayed.

(2) Remove the cap of the Electronic Pen and draw on the
Interactive Panaboard screen using the Electronic Pen.

@®The position on the screen where you are drawing will be
reproduced on the page in the Whiteboard window in real-
time.

Ready [ 1008 = 1228 x 798 pixels (18500 x 8775 mm)

(3) Erase handwritten lines drawn on the Interactive Panaboard screen using the Electronic
Eraser.

®Portions erased on the screen will also be erased on the page in the Whiteboard window.

® The right figure shows the writing area in the Whiteboard mode.
Do not write the shaded area on the right figure.

® Do not cover the position receiver with your hand as this may cause
interactive function to stop functioning.

Position
Receiver

® Press down firmly with the point of the Electronic Pen or the eraser 100mm
on the screen film until you hear a buzzing sound. (3%hs") W—————
® Do not do the followings near the Interactive Panaboard while using
the Whiteboard mode as this may display unnecessary streaks not 35mm 35mm
written in the Whiteboard window. (1%/5") (1%/5")
- Exchanging markers for interactive (Small) of the Electronic Pen

- Setting or removing a marker cap of the Electronic Pen
- Pushing the point of the Electronic Pen
® When exchanging markers for interactive (Small) of the Electronic
Pen, lock the pen holder lever while inserting the marker all the way into the pen holder until you hear a
buzzing sound.
Detection of the marker color may not work well unless the marker is inserted fully into the pen holder.

Remark:

® \When advancing the screen of the Interactive Panaboard, click [Add New Page] in the [Edit] menu to add a
new page.

i
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® Save drawing data in afile
All drawing and erasing operations of the Interactive Panaboard which are reproduced on a page in the
Whiteboard window are automatically recorded. And if the data is saved in the Interactive Panaboard format file
(extension ".ipb", referred to as IPB documents), the details of meetings and discussions written in the
Panaboard can be played back and edited later.

(2) Click [Save As...] in the [File] menu.
@®The Save As dialog box will appear.

(2) Enter the folder where you want to save the file and the file name.

@ The extension of the file is ".ipb".

(3) Click the [Save] button.

®Open the saved data
The saved data can be displayed in the Whiteboard window as well as browsed, played back and edited.

(1) Click [Open...] in the [File] menu.
@®The Open dialog box will appear.

(2) Enter the folder to look in and the file name you want to open.

®The file has an ".ipb" extension.

(3) Click the [Open] button.

Remark:

® Many different operations can be executed in the displayed IPB document.
Save the IPB document in another file format. (See page 50.)
Switch a page of the IPB document. (See page 54.)
Edit a page of the IPB document. (See page 54.)
Playback the IPB document. (See page 57.)
Print the IPB document. (See page 58.)
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m About Whiteboard window

Whiteboard window is a function to reproduce the drawn lines by using the Electronic Pen and the Electronic
Eraser onto the Interactive Panaboard to the computer screen.

Recorded image data can be saved as IPB document. So that you can see the file later. The following functions
are available; Add lines with marker. Erase unnecessary lines with eraser. Copy entire page or partial image to
other general image formats such as Bitmap, JPEG, TIFF and these images can be transferred to other application
software.

Either start with the Whiteboard mode or click [Open Whiteboard Window] in the pop-up menu to get the check
mark in the Whiteboard mode, then the Whiteboard window will appear.

While displaying the Whiteboard window, click [Close Whiteboard Window] in the pop-up menu to delete the check
mark, then the Whiteboard window will disappear.

@ Title bar
8 Interactive Panaboard : Whiteboard Window — [G:¥Proeram Files¥Panasonic¥Interactive Panaboard¥Documents¥WwhiteboardMode.ipbl
Eile Edit Page/Play Wiew Seftines Help
@[Main] Toolbar—————oea|+ & =
/pu-‘| S
@][Page/Play] Toolbar f
@)[Markers/Eraser] Toolbar Panasonic KX-BPBr
(@Main view — Alt-In- One
Titeractive Prist Rogrd
Sclution
Donosrte K B9 el e
. . Al-ln- O o Bl
@Thumbnail view ——| = e
e
©status bar e .
(®Replay mode @lImage size (®Page number
@ Title bar: Indicate the currently opened file name of the IPB document.
(2 Main view: In the main view, the page to be edited is displayed.

When @ (Arrow) is selected in the [Markers/Eraser] Toolbar, a part of page can be copied
into the Clipboard by dragging the mouse. It can be copied to other application software by
drag and drop.

When marker is selected in the [Markers/Eraser] Toolbar, you can draw lines on the page. If
the eraser is selected, you can erase the lines.

(® Thumbnail view: The thumbnail image of the all pages of the IPB document can be displayed.
At the bottom of each page, the last modified date is displayed.
The image in the main view area is indicated as framing in the thumbnail area. To change
the editing page, click another page.

@ Toolbar: Toolbar has buttons which most frequently used functions are formed as icon.
It can be moved in the display area by dragging.
(® Status bar: Indicate the information of the IPB document.
(® Replay mode: Indicate if it is in the replaying or not.
@ Image size: Indicate the page size when it is 100% display ratio.

Page number: Indicate the total number of pages and the page being displayed.

For more details about the Whiteboard window, refer to "View Window or Whiteboard Window Operation" from
page 46.
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View Window or Whiteboard Window Operation

m Differences between the View window and the Whiteboard window

The View window of the Projector mode and the Whiteboard window of the Whiteboard mode are windows which
function to display and edit IPB documents in which the contents of work performed on the Interactive Panaboard
are recorded. Basically, they both have identical functions. However, the Whiteboard window has some functions
the View window does not have. If you understand the differences between the two windows as follows, you will be
able to quickly use both windows just by learning the operations of one window.

Difference

Details

System of units

® The View window displays IPB documents which record work done in the computer
screen that is projected onto the Interactive Panaboard screen by the projector.
Consequently, the size is represented by dots.

@ In the Whiteboard window the state of the Interactive Panaboard screen where the
marker was used to draw is virtually displayed in a computer window. Consequently,
units of length are standard. You can choose between units in millimeters or inches.

® The View window function displays and edits IPB documents created by the Desktop

[Add New Page]:

[File] menu Drawing Tool. Consequently, the [New] menu does not exist.
[New]: @ Close the IPB document currently displayed in the Whiteboard window and displays a
new IPB document.
® The View window function displays and edits IPB documents created by the Desktop
[Edit] menu Drawing Tool. Consequently, the [Add New Page] menu does not exist.

® Add a new page that has no drawing data next to the last page of the IPB document in
the Whiteboard window.

[Edit] menu
[Add Copy Page]:

® The View window function displays and edits IPB documents created by the Desktop
Drawing Tool. Consequently, the [Add Copy Page] menu does not exist.

® Add a copy of the page displayed next to the last page of the IPB document in the
Whiteboard window.

m Menu configuration

Following menus can be used in the View window or the Whiteboard window.

[File] menu

New:

Open:
Save:

Save As:

Print Preview:

Print:

Close the displayed IPB document, create a new IPB document.
(Whiteboard window only) O Page 49
Open an IPB document. O Page 49

Save the displayed IPB document. 0 Page 50
Save the displayed IPB document with new file name. O Page 50

Before printing, check printing layout the displayed IPB document. [0 Page 58
Print the displayed IPB document. [J Page 58
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Export—[ Image:
HTML:
Close View window:

Close
Whiteboard window:

[Edit] menu
Undo:
Redo:

Copy:

Select All:
Add New Page:
Add Copy Page:

Delete Current Page:

[Page/Play] menu

Start:

Go to First Page:

Go to Previous Page:

Go to Next Page:
Go to Last Page:

Go to Page:

[View] menu

[ . . .
#,+ Zoom—Fit Window:

~ 200%:
- 150%:
~ 100%:
- 75%:
- 50%:
- 25%:
- 10%:

Full Screen:

Output the page to the image file (Bitmap, JPEG, TIFF). O Page 50
Output the page to the HTML file. O Page 51

Close the View window. (View window only)

Close the display of the Whiteboard window.
(Whiteboard window only)

Return the drawing lines line by line. O Page 55
Cancel the undo. O Page 55

Copy the selected area in the page to the clipboard.
The page size to be copied is 100% zoom condition. O Page 56

Select entire page. O Page 56

Add a new page next to the last page. (Whiteboard window only) 00 Page 55
Add copied page next to the last page. (Whiteboard window only) O Page 55
Delete the displayed page. O Page 56

Start the replay. O Page 57

Pause the replay. O Page 57

Stop the replay. O Page 57

Display the first page. O Page 54
Display the previous page. 00 Page 54
Display the next page. O Page 54

Display the last page. O Page 54
Display the specified page. O Page 54

Display the current page to fit window. 0 Page 53

Display the current page by 200% of its original size. O Page 53
Display the current page by 150% of its original size. O Page 53
Display the current page by 100% of its original size. O Page 53
Display the current page by 75% of its original size. 0 Page 53
Display the current page by 50% of its original size. O Page 53
Display the current page by 20% of its original size. O Page 53
Display the current page by 10% of its original size. 0 Page 53

Use the entire display area of your monitor to display the current page.
0 Page 53

a7
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Main Toolbar; Switch the Main Toolbar display ON/OFF. O Page 48
Page/Play: Switch the Page/Play Toolbar display ON/OFF. O Page 48
Markers/Eraser: Switch the Markers/Eraser Toolbar display ON/OFF. 0 Page 49
Status Bar: Switch the Status bar display ON/OFF.

[Settings] menu

Information: Store the information of the meeting. 0 Page 58

Play: Change the interval time when replaying the drawing data. O Page 59
Markers and Eraser: Change the color and size of the marker and size of the eraser. O Page 59
Export Image: Set the quality of JPEG or compression of TIFF etc. [0 Page 60

File: Change the folder of IPB document management default or automatic back up

interval timing. O Page 61

Options: Set the measurement unit such as mm or inch and the File path display method to
the title bar. 0 Page 62

[Help] menu
Help Topics: To display help information.
About: To display information about the Interactive Panaboard Software.
m Tool bars

Following menus can be used in the View window or Whiteboard window.

® Main Toolbar

Save Copy Zoom

Main Toolbar

O | B & #1008 =]

\
New Open Print Fit Window Full Screen

*The [New] button is only for the Whiteboard window.

® Page/Play Toolbar

Pause Stop Go to Previous Page Go to Last Page
Page fPlay Toolbar a3
> ou o= J |14 T4

Start Play Scroll bar Go to First Page Go to Next Page
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® Markers/Eraser Toolbar

Blue Marker
Black Marker Eraser

MarkersfEraser Tool... B

X XY

Arrow | Green Marker
Red Marker

To display a Toolbar, click the [View] menu and then click the Toolbar you want to display (any one of [Main],
[Page/Play], [Markers/Eraser]) and add a check mark.

If the Toolbar is already displayed, add a check mark next to that Toolbar.
To turn off the Toolbar, click [View] menu and remove the check mark from the Toolbar you want to hide.
If the Toolbar is not displayed, a check mark will not be added next to that Toolbar.

Remark:

® The Toolbars can be dragged and moved to any location on the screen.

m Create an IPB document (Whiteboard window only)
In the Whiteboard mode, create new IPB document to record work performed on the Interactive Panaboard.

Click [New...] in the [File] menu.

®\When the IPB document currently being edited is changed, a dialog box will display asking you to
confirm the save.

Remark:

® \When the Whiteboard window is displayed, an IPB document is automatically created and a new page is
displayed in the main view.

® \When advancing the screen of the Interactive Panaboard during a meeting, add a new page by [Add New Page]
in the [Edit] menu.

m Open an IPB document
1 Click [Open...] in the [File] menu.
® The Open dialog box will appear.

2 Enter the folder to look in and the file name you want to open.
®The file has an ".ipb" extension.

3 Click the [Open] button.
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Remark:

® To open a recently opened file, click the file name you want to open in the [File] menu. Eight recently opened
IPB documents will be displayed in the [File] menu.

® The IPB documents can also be opened by double-clicking the file icon in the file system.
Whether an IPB document is created in Projector mode or Whiteboard mode, the contents are managed
internally and when opened, the mode they were created in will be switched to automatically.

® To allow a previously saved IPB document to be recovered if a power failure or other incident occurs, add a
check mark to the [Create Recovery File] check box in the [File Settings] dialog box ([Settings] - [File...]) in
advance.
Open the recovery file setting [All Files] in the [Files of type] box as the recovery file have an ".ip~" extension.

m Save the IPB document

Click [Save] in the [File] menu.

Remark:

@ To save a currently open IPB document with a different name, click [Save As...] in the [File] menu.

m Save the IPB document in another file format

Exporting images allows you to save files in another file format to allow the IPB documents to be used in other
applications. This makes it possible to easily distribute the contents of meetings stored in the IPB document to
users whose computers do not have the Interactive Panaboard Software installed.

@ Save the IPB document as an image file

(1) Click [Export] - [Image...] in the [File] menu. B
®The Export Image dialog box will appear. (;‘;';”Tm o I%I
(2) To save all the pages, click [All pages]. e [ _owo_|

In addition, to specify certain pages to be saved, click
[Page from] and then enter the page range.

Clicking the [Setup] button will allow you to set image size, JPEG file quality and TIFF file
compression.

(3) Click the [OK] button.
@®The Save As dialog box will appear.

(4) Enter the folder where you want to save the file, the file name and the file type.

The following file formats can be selected for the [Save as type].
Bitmap Files (*.bmp), TIFF Files (*.tif) or JPEG Files (*.jpg)

(5) Click the [Save] button.
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Remark:

® \When saving multiple pages, files for a certain number of pages (for example, n pages) are created and 2
digits "01, 02, --- On" to represent the page are added on the end of the file name.

@ Settings such as size and compression when saving the IPB document as an image file are managed in
[Export Image...] in the [Settings] menu.

® Save the IPB document as a HTML file

You can save the IPB document as a HTML file in page units.
In addition, meeting information can also be output at the same Fil
t|me to that Index page index file: IC\F’ROGRAM FILES\PANASONICUNTERACTIVE PAMAE fi ...}
Setting multiple pages and saving the IPB document as a HTML Page Image: Width [0 xHelaht [519 pliels 7 Constrain Proportons
file will create an index file, linked HTML pages and images. e e €561 | Y et | R et (oA it it
Using this method will allow the contents of meetings recorded in | epotrange - Expn Contents
the IPB documents to be easily provided to people using b T
. - = v Fage Date
computers with Web browsers installed. craes [ ¥ Greated Date
Enter page numhbers andfor page ranges ~ Modified Date
separated by commas. Forexample, 1,3,5-11 ¥ Patticipants
(2) Click [Export] - [HTML...] in the [File] menu. -co o
Background (k). Table Labels(@): ;7 Dtsl::mmn
@®The Export HTML dialog box will appear. ) _ " Contacts
Textix): [ Tahle ltems(Z): I G
(2) Specify the folder where the IPB document will be ok | cancal | _ pwan_|

saved as a HTML file in the [index file].
@ Selecting [All Pages] will output all the pages of the displayed IPB document to the HTML files.

@ Selecting [Current Page] will output only the page displayed in the main view to the HTML file.

@ Selecting [Pages] will output the specified page or the specified page range to the HTML file. Enter a
comma to separate the page numbers to output the specified pages. In addition, when specifying a page
range, use a hyphen to connect the first page number and the last page number.

(3) If necessary, change the other export settings shown below and click the [OK] button.
[File] group

Page Image: Enter the width and height of the image of the exported page in pixel units.
Checking (turning ON) the [Constrain Proportions] check box on the right side
will preserve the ration of the length and height of the page even if the
dimensions of the exported page are changed.

Thumbnail Image: Enter the width and height of the thumbnail image of the exported page in
pixel units. Checking (turning ON) the [Constrain Proportions] check box on
the right side will preserve the ration of the length and height of the page even
if the dimensions of the exported page are changed.

[Colors] group

Background: Select the color of the background of the HTML file.

Text: Select the color of the text used in the HTML file.

Table Labels: Select the background color of the labels of the tables in the HTML file.
Table ltems: Select the background color of the items of the tables in the HTML file.

@ Clicking the rectangular colored portion will display the Color dialog box. Click
the color from the Basic colors. 51
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[Export Contents] group

Thumbnail Image:
Page Date:
Created Date:
Modified Date:

Participants:
Manager:
Subject:
Description:
Contacts:

Company:

Turn this check box ON to add a thumbnail image of the page to the index page
of the exported HTML file.

Turn this check box ON to display the date and time the page was created on
the index page of the exported HTML file.

Turn this check box ON to display the date and time the IPB document was
created on the index page of the exported HTML file.

Turn this check box ON to display the date and time of the last update done to
the IPB document on the index page of the exported HTML file.

Turn this check box ON to display the participants of the meeting information set
in [Information...] in the [Settings] menu on the index page of the exported HTML
file.

Turn this check box ON to display the manager of the meeting information set in
[Information...] in the [Settings] menu on the index page of the exported HTML
file.

Turn this check box ON to display the subject of the meeting information set in
[Information...] in the [Settings] menu on the index page of the exported HTML
file.

Turn this check box ON to display the description of the meeting information set
in [Information...] in the [Settings] menu on the index page of the exported HTML
file.

Turn this check box ON to display the contacts of the meeting information set in
[Information...] in the [Settings] menu on the index page of the exported HTML
file.

Turn this check box ON to display the company name of the meeting information
set in [Information...] in the [Settings] menu on the index page of the exported
HTML file.

® \We recommend saving HTML files in folders where HTML files exported from other IPB documents are not
stored. If you attempt to save a file in an already existing folder, a message will be displayed asking you to
confirm whether or not to overwrite the already existing HTML file.

Remark:

® \When exporting multiple pages to HTML files, an index file "index.html" and HTML files named after the
page numbers (for example, n pages) "page_01.html, page_02.html, page_03.html, --- page_0On.html" are
created. Images displayed in the HTML files named after the page numbers "page_01.jpg, page_02.jpg,
page_03.jpg, --- page_0n.jpg" are also created.
If the Thumbnail Image check box is turned ON, thumbnail images displayed in the HTML files named after
the page numbers "small_01.jpg, small_02.jpg, small_03.jpg, --- small_0n.jpg" are also created.
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m Change display method

®Display expanded/reduced page
You can expand the page and display a portion of the page larger or reduce the page and display the entire

page.
(1) Position the cursor over [Zoom] in the [View] menu and click the percentage (%) you want
to display.

Remark:

@ You can also enter a numeric value into |1 (0% 'I (Zoom) to change the display percentage. The percentage
can be set in units of 1%.

®Display page at the same size of the main view
(1) Click [Fit Window] in the [View] menu.

®Display page as large as possible
To display the page on the screen as large as possible, switch to full screen display mode.
In this mode the toolbar is displayed as a free toolbar.

(2) Click [Full Screen] in the [View] menu.

®To exit full screen display mode and return to the original display mode, right-click the mouse and
click [Full Screen] in the pop-up menu.

Remark:

® To turn OFF the Toolbar in full screen display, right-click the mouse and click the Toolbar you want to turn
OFF in the pop-up menu and remove the check mark.
In addition, to display the Toolbar, click the Toolbar you want to display in the pop-up menu and add the
check mark.
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m Switch a page of the IPB document
®Display first page
(1) Click [Go to First Page] in the [Page/Play] menu.

®Display previous page
(1) Click [Go to Previous Page] in the [Page/Play] menu.

@ Display next page
(1) Click [Go to Next Page] in the [Page/Play] menu.

®Display last page
(1) Click [Go to Last Page] in the [Page/Play] menu.

® Specify a page number to display
(1) Click [Go to Page...] in the [Page/Play] menu.

®The Go to Page dialog box will appear.

(2) Enter the page number you want to display in [Go to Page:].

(3) Click the [OK] button.

Remark:

® To quickly display a page, click the thumbnail display of the page you want to display in thumbnail view.

m Edit a page of the IPB document

You can edit pages displayed in the main view in the View window or Whiteboard windows as follows.
@ You can use the marker or eraser for additions and modifications.
® You can add a page. (Whiteboard window only)
® You can delete a page.
@ You can select portions or entire page and save the contents in the clipboard or copy to other applications.

®Draw and erase handwritten lines on a page
(1) Display the page where you want to draw or erase handwritten lines in main view.

(2) To draw handwritten lines, click either (Black Marker, Red Marker, Blue Marker or
Green Marker) in the [Markers/Eraser] Toolbar.

®The shape of the mouse cursor changes to ﬁ% .

(3) Position the mouse where you want to draw a handwritten line on the page and drag the
mouse.



View Window or Whiteboard Window Operation

(4) To erase handwritten lines, click (Eraser) in the [Markers/Eraser] Toolbar.
®The shape of the mouse cursor changes to h

(5) Drag the mouse to the area on the page you want to erase.

Remark:

@ To return to the state before the changes, click [Undo] in the [Edit] menu.
® The width and color of the markers and the size of the eraser can be changed.

®Undo

You can return handwritten lines drawn using the marker or erased using the eraser to their original state,
stroke by stroke.

(1) Click [Undo] in the [Edit] menu.

@®To return to the previous state, click [Undo] again.

Remark:

@ To perform the operation that was undone once again, click [Redo] in the [Edit] menu.
® The [Undo] / [Redo] can be used over and over however if the page changes, the [Undo] / [Redo] may reset.

®Add a new page to the IPB document (Whiteboard window only)
In the Whiteboard mode, add a new page next to the last page of the IPB document.
When advancing the screen of the Interactive Panaboard during a meeting, add a new page.

(1) Click [Add New Page] in the [Edit] menu.

® A new page will be added next to the last page of the IPB document and the display switched to that
page.

Remark:

® A maximum of 50 pages can be recorded. This software cannot add more than 50 pages.

@®Add a copy of the currently displayed page to the IPB document (Whiteboard window
only)

In the Whiteboard mode, add a copy of the page currently displayed in main view next to the last page of the
IPB document.

Use this to leave the current contents on the screen of the Interactive Panaboard unchanged while adding new
changes.

(1) Click [Add Copy Page] in the [Edit] menu.

® A copy of the currently displayed page will be added next to the last page of the IPB document
and the display switched to that page.

Remark:

® A maximum of 50 pages can be recorded. This software cannot add more than 50 pages.
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®Delete currently displayed page
(1) Display the page you want to delete in the main view.

(2) Click [Delete Current Page] in the [Edit] menu.

® A dialog box will be displayed asking you to confirm the delete.

(3) Click the [OK] button to delete.

@ Use caution because deleted pages cannot be recovered to their original state by [Undo] in the [Edit] menu.

® Select page
(1) Click (Arrow) in the [Markers/Eraser] Toolbar.

(2) Diagonally drag the mouse over the portion of the page you want to select.

@®The selected area will be displayed in reverse.

@ To select the entire page, click [Select All] in the [Edit] menu.
The entire page will be displayed in reverse.

Remark:

® To cancel the selected state, click outside of the selected area.

® Copy selected page range to clipboard

(1) Click (Arrow) in the [Markers/Eraser] Toolbar and drag the mouse to select the portion
of the page you want to copy.
In addition, to select the entire page, click [Select All] in the [Edit] menu.

@®The selected area will be displayed in reverse.

(2) Click [Copy] in the [Edit] menu.

Remark:

® To cancel the selected state, click outside of the selected area.
® The Image copied to the clipboard can be pasted in other applications.
® The Image copied to the clipboard becomes BMP image.
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@ Copy selected page range to other application by dragging and dropping

You can copy data to other applications by dragging and dropping the selected page area. To perform this

operation, the application copied to must support OLE (Object Linking and Embedding).

(1) Open the file where the data will be copied to and adjust the position of the application
window such that the page to be copied and the file to be copied to are displayed in the
screen. Arrange the documents such that both the information to be dragged and the
position where that information will be dropped are displayed.

(2) Click (Arrow) in the [Markers/Eraser] Toolbar and drag the mouse to select the portion
of the page you want to copy.
In addition, to select the entire page, click [Select All] in the [Edit] menu.

®The selected area will be displayed in reverse.

(3) Drag the selected area to the copy destination of the other application.

Remark:

@ To cancel the selected state, click outside of the selected area.
® The file formats when copying by dragging and dropping can be selected from the formats below.
Bitmap Files (*.bmp), TIFF Files (*.tif) or JPEG Files (*.jpg)

m Playback the IPB document

The operations of drawing and erasing handwritten lines on each page are automatically recorded in stroke units
and the locations of the drawing can be played back and confirmed later.

- :
1 Click [I%] (Start) in the [Page/Play] Toolbar. —— T TG

® The Play Scroll bar in the [Page/Play] Toolbar will move
to the left end to return the page content their original state, and then the playback will start.
@ To stop the playback in the middle, click (Pause) in the [Page/Play] Toolbar. To restart

the playback in the middle, click (Start) in the [Page/Play] Toolbar.

® While stopping temporarily, you can move the Play Scroll bar in the [Page/Play] Toolbar to
playback manually.

®To end the playback in the middle, click E| (Stop) in the [Page/Play] Toolbar.

2 When the Scroll bar moves to the right end, the playback will end.

Remark:

@ You can click the arrows at the right and left of the Play Scroll bar or drag the Play Scroll bar to the right or left to
playback the drawing.

® While playing back, you cannot use the marker and eraser in the [Markers/Eraser] Toolbar. In addition, in
Whiteboard mode drawing on the screen of the Interactive Panaboard will not be reproduced either.

@ You can adjust the playback interval. (See page 59.)
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m Print the IPB document

® Confirm print image of the IPB document before printing
(1) Click [Print Preview] in the [File] menu.

@® Switch to the Print Preview screen.

(2) Click the [Close] button to exit the Print Preview and return the display mode to the
original state.

Remark:

® The screen display mode that displays an image of the file when it is printed is called the Print Preview. In the
Print Preview you can display print images of multiple page at a time. You can also expand or reduce the size
of the page displayed in the screen.

@ Print currently displayed IPB document
(1) Click [Print] in the [File] menu.
@®The Print dialog box will appear.

(2) Set the [Printer], [Print range] and [Number of copies].

(3) Click the [OK] button.

@®The Printing dialog box will appear.
@ To stop the printing, click the [Cancel] button in the Printing dialog box.

m Settings
@ Setting meeting information
Set meeting information recorded in the IPB
document. Information that can be saved includes [ EIET e
. . . . .. itle: |Market Trend Meeting ame lm—
titles, subjects and descriptions, participants and anni :DM v ima” lh:’za@p—m
related contact information. oo [Fansson: o rrry P —
Setting the information of a meeting will also allow Hanager: [Tom
you to output page images when exporting the IPB Sreatogon: [FTVEREN TS7E4T ‘C”"‘a”;;me ——
documents to HTML files. Modified On; [P110172007 131 4:40 emal [
1 1 1 1 ubjec raduct Market Tren S l—
(1) Click [Information...] in the [Settings] susiet [FrodiiHarei s o
menu Description: :Lﬂrat:'lgign&;?;aesgtv ;I
: LI Cancel

@®The Information dialog box will appear.

(2) Enter necessary information as follows, and then click the [OK] button.
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[Summary] Enter a summary of the recorded meeting here.
Title: Enter the title of the meeting.

Participants: Enter the participants of the meeting.
Company: Enter the name of the company.
Manager: Enter the individuals responsible for the contents of the meeting.
Create On:  Automatically displays the date and time the IPB document was created.
Modified On: Automatically displays the date and time the IPB document was updated finally.
Subject: Enter the subject of the meeting.
Description:  Enter a description of the contents of the meeting.

[Contacts] Enter information to contract individuals for questions concerning the meeting here.
Name: Enter the names of the person in charge of the meeting.
e-mail: Enter the e-mail address of the person in charge of the meeting.

Home page: Enter the home page of the person in charge of the meeting.

@ Set the interval when playing back the IPB document

(1) Click [Play...] in the [Settings] menu. Playback Sotting
@®The Playback Setting dialog box will appear. ‘”‘”“,%”;‘f;ffj,”j;;ﬂfs

reEt I

(2) Enter an interval for playing back the stroke in the Interval time
between strokes. o] cancel peraut |

You can click the arrows at the right and left of the scroll bar or
drag the scroll bar to the right or left to set a desired interval.

Remark:

® The playback interval can be set in a range of 0 - 2 seconds in 1 msec (millisecond = 1/1000 second) units.

@ Set the marker width, color or the eraser size
Change the width and color of the markers and the size of the eraser used in the View window or the
Whiteboard window.
The marker width and color can be changed for four marker colors.

(1) Click [Markers and Eraser...] in the [Settings] menu. [EEE=ETS —— =
®The Marker/Eraser Setting dialog box will appear. Ak 9 ehangs colr EET
Black 33: ] £
Red 33: 015 fr—
Blue: 33: L —— O
Green 33: dots
Cancel Default
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(2) To change the width of the markers, either enter a width in [ 3w (Marker Width) at the

right side of the marker whose width will be changed or click the up/down arrows on the
right side to set a desired width.

To change the color of the markers, click ——— (Marker Color) on the right side of the

marker whose color will be changed. The Color dialog box will appear. Click the color you
want to change from among Basic colors, and click the [OK] button.

To change the size of the eraser, either enter a size in | 4 wts (Eraser Radius) or click
the up/down arrows on the right side to set a desired size.

(3) Click the [OK] button.

(4) A dialog box will appear where you can select whether or not to apply the new settings to
handwritten lines drawn up to now.
Clicking [Yes] button will redraw the lines drawn up to that point using the new settings.
Clicking [No] button will only reflect the new settings for any subsequently drawn lines.

Remark:

® The unit of the maker width and the eraser size is dots in the View window and millimeters or inches in the
Whiteboard window.

® The marker width can be set in a range of 1 - 30 dots in the View window and 0.1 - 25.4 mm (0.01 - 1 inch) in
the Whiteboard window.

® Even though the marker colors are changed, the colors of the marker buttons in the [Markers/Eraser] Toolbar
and the mouse cursor will not change.

® The eraser radius can be set in a range of 1 - 60 dots in the View window and 0.1 - 50.8 mm (0.01 - 2 inch) in
the Whiteboard window.

® These settings are effective until being changed.

® Set an image file when exporting or copying by dragging and dropping
Set the size when exporting a page to an image file and the file
format to create when copying data to other applications by i ——
dragging and dropping a selected page area. wigth Helght
. . . Image Size I a00 ,(I 519 Pixels | Constrain Proportions
(1) Click [Export Image...] in the [Settings] menu.
JPEG: Quality [ 702 (0-100)

@®The Export Image Settings dialog box will appear. TIFF: [~ Compression(PACKBITS)

Export Image Settings

~Drag and Drop Files
& WindowsBMPE brnp)

CJPEGE jpg) Gl 0= (=0 Cancal |

" TIFF(~tify ™| CompressioniRACKEITE) ST |
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(2) The following items can be set.

[Export Image Files] group

Image Size: To change the size when saving a page as an image file, enter a desired width and
height.
Check (turn ON) the [Constrain Proportions] check box when setting the aspect ratio of
the page to an identical value even if the page dimensions change while saving it as
the image file.

JPEG: To set the quality level when exporting a page as a JPEG format image file.

TIFF: To perform compression when exporting a page as a TIFF format image file, check
(turn ON) the [Compression (PACKBITS)] check box.

[Drag and Drop Files] group

Set the file format to create when copying data to other applications by dragging and dropping a
selected page area.
The following file formats can be selected.

WindowsBMP (*.bmp), JPEG (*.jpg) or TIFF (*.tif)

If JPEG is selected, you can enter a quality level in [Quality:].
If TIFF is selected, you can set Compression/No-compression using the [Compression
(PACKBITS)] check box. Turn the check box ON for compression.

(3) Click the [OK] button.

Remark:

® The default of the width is 800 dots and the [Constrain Proportions] check box is checked (ON). The height
will be different depending on the size of the Panaboard screen and the screen resolution of the PC where

the projector is projecting the image.

® Set a work folder and the recovery file
Set the default folder when saving an IPB document.
In addition, if settings are made to automatically create a recovery
file, previously saved IPB documents can be recovered if a power
failure or other incident occurs.

File Settines E3

Save Default Eolder:
|C:IPROGRAMFILESIPANASONICIINTERAC' ﬂrowse...l

H H H H ¥ Create Recovery File
(1) Click [File...] in the [Settings] menu. e ocovan Fils alter
®The File Settings dialog box will appear. ¢ Same folder as orignal file
IC:IPROGRAM FILES\PAMASOMICUMNTERACT Elrowse...l
(2) The following items can be set. Save automatically every [ 5= minutes
Save Default Folder: Set the path of the folder
you want to display as a Cancel | __Defaut
default when saving a new
IPB document.
Create Recovery File: To create a recovery file, add a check mark (turn ON).
Recovery File Folder: To save the recovery file at the same folder as the original file, add a

check mark (turn ON) to the [Same folder as original file] check box.
Otherwise, set the directory to save the recovery file.

Save automatically every x minutes: To set the automatic save interval of the recovery file in a range of
1 - 120 minutes.

(3) Click the [OK] button.
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@ Option setting
Set the display method of the file name in the Title bar and the display unit system.

(1) Click [Options...] in the [Settings] menu.
@®The Options dialog box will appear. [ Display full path in Title: bar '

Measurement. & mm " inch Cancel |

(2) The following items can be set.

Display full path in Title bar: To display the full path of the currently opened file in the title bar of the View
window or the Whiteboard window, add a check mark (turn ON).

Measurement: To switch the display unit system of the Whiteboard window.

(3) Click the [OK] button.

Remark:

® The computer screen will be projected onto the screen of the Interactive Panaboard in the Projector mode
and because there is no physical size, the display unit system is only in pixels (dots) and cannot be changed.

® The display unit systems of millimeters / inches are used as units to represent the page size on the status
bar, pen width and eraser size.



Remote Conferencing using Microsoft® NetMeeting®

m About NetMeeting®

Microsoft® NetMeeting® is a software to share information with the computer connected in the network. When the
Interactive Panaboard is connected with the computer connected in the network and NetMeeting® is used, it is
possible to confer on the remote place using the Projector mode or the Whiteboard mode of the Interactive
Panaboard Software.

It is necessary to install NetMeeting® in each computer which confers on the remote place. We recommend using
NetMeeting® 3.0 or later. You are able to download latest NetMeeting® from the Microsoft® Corporation
NetMeeting® Home Page of the Internet. (http://www.microsoft.com/windows/NetMeeting/)

This section explains an example of the remote conferencing using NetMeeting®.
For detailed explanation concerning NetMeeting®, please refer to help of NetMeeting® or the Microsoft®
Corporation NetMeeting® Home Page of the Internet.

m Example of using NetMeeting®

1 Connect the Interactive Panaboard with the computer which sponsors the remote
conferencing, and run the Interactive Panaboard Software with the Projector mode or the
Whiteboard mode.

2 Run NetMeeting® with all computers which confer on the remote place.

3 Call the computer which participates from the computer which sponsors the remote
conferencing.

®To call, select from the user who connects the computer with the Internet directory server or input
IP address directly.

4 Receive the call with the computer which participates in the remote conferencing.

5 Share a program of the computer which sponsors the remote conferencing.
®\When you use the program sharing feature, other people can see the program.
®\When the Projector mode is used, share the Desktop.

®\When the Whiteboard mode is used, share the Whiteboard window of the Interactive Panaboard
Software.

®\When you allow control, other people can both see and use the program.
Itis only one person at atime to be able to control the shared program.

6 Confer on the remote place using the shared program.

When the remote conferencing finishes, stop sharing a program and exit NetMeeting®.
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@ You cannot call people on the Internet that you have located on Wed-based directory servers if your Internet
connection uses a proxy server that does not support NetMeeting®.

®\When you share a program and decide to allow someone to control it, remote users can use the File Open
and File Save dialog boxes in your program to gain access to or delete files on your computer or network.
It is recommended that you do not leave your computer unattended while sharing a program and allowing
control.

@ You can connect to only one other person with audio and/or video at a time.



Daily Care and Maintenance

Always turn off the power switch and unplug the power plug when cleaning outside and inside the unit.

Cleaning the screen and the unit

Gently wipe the screen film and unit with a water-dampened
cloth that has been thoroughly wrung.

Use a commercially available white board cleaner for
hard-to-clean stains. (SANFORD® EXPO® white board
cleaner etc.)

If you accidently write on the board with an oil-based
marker, wipe with a small amount of ethyl alcohol.

® Do not use thinner, benzine or cleaners containing
abrasives as this may result in discoloration.

® Do not wipe the screen film with a dry cloth as this
may generate a static charge.

Caring for the eraser

When the erasing surface of the eraser becomes dirty, hold
down the sheet under the top sheet with your finger and peel
off the dirty sheet by pulling in the direction of the arrow.

®When the eraser becomes thin, make sure that the
corners of the eraser do not strike the screen during
erasing as this may damage the screen.

—— 1

% :

Cleaning the printer head, platen roller and feed roller

o |f black streaks appear on the copy, clean the printer head and the platen roller.

® |f paper jams occur frequently, clean the feed roller.

1 Push down the printer open lever and open the
printer door.

Printer Door
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2

3

| Clean the Printer Head |

Dampen the tip of a cotton swab in ethyl
alcohol and gently wipe the printer head.

® Never touch the printer head or the surrounding
area with your hands as this may disable

copying.

Cotton Swab

Printer Head
(Gold)

| Clean the Platen Roller and the Feed Roller |

Remove the film cassette with both hands and
carefully wipe any dirt or stains off the platen
roller and feed roller.

® For details on removing the film cassette, see
page 20.

®Dampen a soft cloth with neutral kitchen
cleaner diluted in water, wring the cloth
thoroughly, and wipe the entire surface of the
rollers while rotating them. If this does not
remove all dirt, wipe with a cloth dampened
with ethyl alcohol.

Attach the film cassette in its original position
and close the printer door.

® For details on attaching the film cassette, see
page 14.

® Close the printer door firmly until a click is
heard.

®If "™ " is displayed on the multi-copy/error
indicator when the power is turned on, this
indicates that the film cassette has not been
installed properly or that there is slack in the
thermal transfer film. Check the condition of the
film cassette and for slack in the thermal
transfer film.

\—Feed Roller
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Replacing the Batteries in the Electronic Pen and the Electronic Eraser

As the lifetime of the batteries in the Electronic Pen or the Electronic Eraser comes near to the
end, the message “Low Battery” appears on the PC screen to which the electronic print board is
connected using interactive functions. When this message appears, get new batteries ready and
replace the old ones as soon as possible.

When replacing batteries, remove the old batteries and replace according to step 1 under “Setting
the Electronic Pen” on page 24 in the case of the Electronic Pen or according to “Setting the
Electronic Eraser” on page 25 in the case of the Electronic Eraser. Continued use of low batteries
may result in a shifting of position or malfunction.

Replacing the Cloth of the Electronic Eraser
If the cloth of the Electronic Eraser becomes dirty with erased markings, replace with a new eraser
cloth according to “Replacing the eraser cloth” on page 25.

Troubleshooting

Treat problems according to the information given in the table below. If problems still persist, call your dealer for service.

See
Symptom Care and Remedy Page
Power switch is on but the | Check that the power plug is securely plugged in.
indicator is off. (If the indicator still does not light, turn the power off and on again.)
The unit is out of copy paper or thermal transfer film. (Error indicator flashes " = "or " - ".) 16
== |nsert copy paper or replace the thermal transfer film. 20
The printer door is open. (Error indicator flashes " o ".)
- . ' . o 15
Copied copy paper will not Close the printer door firmly until a click is heard.
come out. Paper is jammed in the printer. (Error indicator flashes " ./ *.) 01
==  Open the printer door and remove the jammed paper.
The platen roller and feed roller are dirty.
==  Open the printer door and clean the platen roller and the feed roller. 65
® The markers for interactive (Small) are used.
=P  Use the markers (Big).
Nothing is pr!nted Or]l t_h? ® The writing on the screen is too thin or light.
Eﬁﬁ?édor copies are taint or =P \Make thicker, darker lines or change to a new marker.
The printer door is slightly open.
==  Close the printer door firmly until a click is heard. 15
The printer head or platen roller is dirty.
==  Open the printer door and clean any dirt off the printer head and platen roller. 65
Black streaks or blank The room temperature is 10°C (50°F) or lower.
(unprinted) spots appear == |ncrease the room temperature, turn the unit's power off and on, and retry copying.
on the copy (copy paper is . ) _ _ _
dirty) The thermal transfer film is wrinkled because it was set in place without removing
' excess slack. 15
= Rewind the used portion of the thermal transfer film to remove the excess 21
slack, then reattach it.
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Troubleshooting

See
Symptom Care and Remedy bane
The screen does not
advance when the COPY Static electricity was generated when the screen film was wiped.
or ADVANCE keys are ==  Turn off the power and slowly move the screen by hand.
pressed.
. The time to replace the thermal transfer film is approaching. (Only about 15 more
f(ion_trz(i;tll'\;err;fun;]ng copies can be made.) 20
lim Indicator fiashes. —) Prepare a new replacement film (KX-BP081 or KX-BP082).
The computer can not Check that the interactive cable is securely connected. 26
recognize the electronic I - ,
. Communication port setting is not appropriate.
print board when the == Change communication port setting according to “COM port” on page 30 30
interactive function is used. :
The Elgctronlc Pen position The projection position shifts.
may shift when t.he ==p  Calibrate to reposition the projected image on the screen. 33
Projector mode is used.
® Use the Electronic Pen inclined at an angle.
® Direct sunlight or strong light is striking the screen.
Data written on the ® A remote controller is being aimed at the receiver on the electronic print board.
electronic print board may | @ The side of the electronic print board is placed near the wall, or the top of the
disappear from the electronic print board is placed near the ceiling.
electronic print board ® The electronic print board is placed near the vents of an air conditioner.
screen and the computer ® The receiver of the electronic print board is blocked by a hand or other object.
screen or its position may ® The transmitter of the Electronic Pen or the Electronic Eraser is covered with your
shift when the interactive hand.
function is used. ® Two or more the Electronic Pens or the Electronic Eraser are used at the same time.
o |f the position shifts for reasons other than the above, adjust the position according
to "Adjustment” on page 31.
Do not do the followings near the electronic print board while using the interactive
Unnecessary streaks not )
written are displayed on the function.
play ® Exchanging markers for interactive (Small) of the Electronic Pen
computer screen when the . A .
) . L ® Setting or removing a marker cap of the Electronic Pen
interactive function is used. . i .
® Pushing the point of the Electronic Pen
Detection of the marker The marker for interactive (Small) is not securely set.
; Rotate the pen holder lever to the release potion, and then return the pen
color of the Electronic Pen | ™= p !t €eleasep _ p 24
does not work well when holder lever to the lock position while inserting the marker until you hear a
the Whiteboard mode of buzzing sound.
the interactive function is The proprietary marker for interactive (Small) is not set into the pen holder.
used. ==p  Use the proprietary markers for interactive (Small). 71
The me,,ssage e Replace batteries of the Electronic Pen or the Electronic Eraser which have “Low
Battery” appears on the 67

computer screen.

Battery” message displayed.




Troubleshooting

® Meanings of various displays
The following table describes the meaning of each of the symbols which may flash in the Multi-Copy/Error indicator.

Indication Cause Remedy Prge
F’ Out of paper. Load copy paper. 16
,-,’ The printer door is not closed securely. Close the printer door securely. 15
_ The thermal transfer film is slack or has run Remove the slack from the thermal transfer film 15
/ out. or replace. 20
( . Open the printer door and remove the jammed
Paper jam. 21
_( paper.
) . Remove any chart paper attached to the screen
_ The screen will not move.
( and slowly move the screen by hand.
) The room temperature is 10°C (50°F) or lower. Increase the room temperature.
U The fluorescent lamp is dead. Call your dealer for service.
e |f other indications such as " H " appear, call your dealer.
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Specifications

Model Number

KX-BP800

Electronic Eraser

Power Supply AC100 -120 V, 50/60 Hz
Power Consumption
. 22A/01A
(Operational/Standby)
External Dimensions Without stand 1,4000J1,55000240 mm (4' 7Y/"05' 1%=2"[197/16")
HeightOWidthO
© | Depth With stand 1,87501,55001,100 mm (6' 1%/:"05' 1/:"03" 7%/16")
()
5 Weight (without stand) 34.0 kg (75 Ibs)
o Interactive Function
. . . Temperature : 15 - 30°C (59 - 86°F), Humidity : 30 - 80% R.H.
Ambient Operating Conditions Other than Interactive Function
Temperature : 10 - 35°C (50 - 95°F), Humidity : 30 - 80% R.H.
_ti *
Writing Implements Dry erase felt tlpped markers (blgck, req, blue and green*)
* The green marker is only for the interactive function.
Screen Size 1,651 mm (65") Diagonal
é Panel Surfaces 2 (endless type)
m Panel Advance System Scroll type
—
= Copying Area
o h . 850001,330 mm (2' 9%%/:."[14" 43/s"
c HeightOWidth (2 9% ")
Scanning System CCD flat-scan type
Printing System Fusion thermal transfer type
Copy Paper Standard or recycled paper [60 - 90g/ m? (16-24 Ibs)]
Copy Paper Size Letter [21600279.4 mm (8%2"011")]
S Copy Density 8dots/ mm (203 dots/inch)
o
m Copy Color Black
)
= Contrast Adjustment Two levels: Normal/Dark
=
8 2-Screen Compressed Copying Yes
Time Required for Copying 15 sec. /sheet
Continuous Copies 1to 9 sheets
Out-of-Paper Indication Yes
Projector mode: 850001,330 mm (2' 9%/:"[04" 4%/s")
* The position cannot be detected within 50 mm (2") of the upper screen border.
. Whiteboard mode:  82501,330 mm (2' 8%/:."04" 4%/5")
= Effective Area , . - .
o . . * The whiteboard cannot not be written on within 50 mm (2") of the upper screen border and 25 mm
= HeightOWidth .
o (1") of the lower screen border.
= * It is not always possible to normally detect the position within 200 mm (3%%/:6")
'j.'; of the position receiver and 35 mm (1%/s") from the both sides of the screen.
=
= Interface RS-232-C
% Battery for Electronic Pen or LRO3 (“AAA” size) 02

* Alkaline battery

Battery Longevity for Electronic
Pen or Electronic Eraser

48 hours [Continuously at 25°C (77°F)]

* When using Panasonic “LR03" (“AAA” size) alkaline batteries.




Specifications

B Consumable and accessories

Wall-mounting Kit

KX-B063

Stand

KX-BP065

PC Interface Kit

KX-BPQ95 (for connection to PC)

Replacement Film

KX-BP081 [contains two 100m (328.1") rolls]
KX-BP082 [contains 100m (328.1") roll and film cassette]

Markers (Big) and Eraser Set

for Print
Board

KX-B035 (contains one black, one red, one blue marker,
and one eraser)

Pen Holder

KX-BP038

Electronic Eraser

KX-BP048

Marker (Small) set

KX-BP0385 (contains one black, one red, one blue and
one green marker)

for Interactive

Eraser Cloth (for Electronic Eraser)

KX-BP0481 (set of 10 cloths)

* Ruler kit (KX-B05) can not be used with the interactive function.
® The markers (Big) and the eraser are used for other than the interactive function.

® The markers for interactive (Small) are used while inserted in the pen holder.
The Electronic Pen [a marker for interactive (Small) inserted in the pen holder] and the Electronic Eraser are used

with the interactive function.\
® PC Interface (Option)

When the optional PC Interface Kit (KX-BP095) is used, you can scan monochrome images from the KX-BP800 into
a computer running Microsoft® Windows® or Windows NT® and print documents on the computer to the printer of the

KX-BP800.
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Installation Manual

(for qualified service personnel)

, Table of contents
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Before installing this set, please read this manual completely.
For instructions on installing the software, please see page 27.

Accessories

The following accessories are required for assembly.

Part name Part illustration/quantity Attachment procedure

Power cord 11 Page 75, ltem 4.1

Wall mounting template 1

! Page 82, Iltem 2
(for wall mounting) I I

All accessories included in the package are given on the next page.
Make sure that all of these parts are included in the package before proceeding.

A WARNING

® DO NOT INSTALL THIS OPTION EXCEPT QUALIFIED SERVICE PERSONNEL.

A CAUTION

SAFETY CHECK MUST BE DONE BY QUALIFIED SERVICE PERSONNEL
AFTER INSTALLING THIS OPTION.




Assembling the Print Board

m Assembly

-

\

1

Assembly of the optional stand or wall-mounting kit.

m |f you are using a stand, refer to page 78.

m If you are using a wall-mounting kit, refer to page 81.

Remove the print board from the shipping box.

Remove the joints, then remove the print board from the shipping box.

® Filmcassette ............. ... .. ...
®Bluegear.......cooiiiiii
® GreeN gearS .....ovv ettt
® Thermal transfer film [20m (65.6)] .......

® Markers (Black, Red, Blue-Big) - - - - - - - Each 1
@ EraSer « -+ -+ r vt vttt 1
® Letter papers - - - - - 20 sheets
® Penholder - -« - -« - oo 2
® Markers for interactive

(Black, Red, Blue, Green-Small) - - - - - - Each 1
® ElectroniC eraser « - -« -« 1
® Eraser cloth (for electronic eraser) - - - -« - - - 2
® Batteries (LRO3 "AAA") - - -« -voveii e 6
® POWEr COId - -+« v s e e e e 1
® |nteractive cable (Sm) ................... 1
® Software CD-ROM « + «+ + v v v v v v i 1
® Operating Instructions - - = =+« oo v v 1
® Software License Agreement - - - -« .. ... 1
® Wall-mounting template: - - - -+ -« - o oo e e 1
[ ] Warranty card - - - - 1

® Do not touch the screen film surface as doing so may damage it.
@ The shipping box, cushioning material, and other packaging materials will be necessary if
you ever need to repackage the print board, so do not throw them away.

uolre|eisul
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Assembling the Print Board

-

3 Attach the print board.

m If you are using a stand:
1. Hang the print board on the

2. Use the two wing bolts (M5
12 mm) provided with the stand
to fasten the print board to the
lower stand attachment fixtures
as shown below.

attachment fixtures of the stand.

/

® The stand (KX-BP065) is available as an option.

m If you are using a wall-
mounting Kit:

1. Remove the two wing bolts and
hang the print board on the wall-
mounting fixtures supplied with
the wall-mounting kit.

(Please refer to page 82.)

2. Use the two wing bolts removed in
step 1 above to fasten the print
board to the lower wall-mounting
fixtures as shown below.

® \When mounting the print board, avoid banging it.
Such impact may break the internal fluorescent
light or cause other damage.

@ After mounting the print board, gradually apply

weight to it to make sure that the wall is strong
\ enough to support it. /

® The wall-mounting kit (KX-B063) is available as an
option.



Assembling the Print Board

Attach the power cord.

1. Securely fit the supplied power
cord into the AC inlet on the
printer unit.

—

)

2. Fit the power cord into the cord
holder. Do not force it.

Cord Holder

\--

A

~

~

5 Wipe the screen film surface.

Wipe the screen film gently with a
water-dampened cloth that has
been thoroughly wrung.

— 17

N

N

® Do not use thinner, benzine or cleaners
containing abrasives as this may result in
discoloration.

® Do not wipe the screen film with a dry
cloth as this may generate a static
charge.

6 Check operations.

Refer to page 76 "Print Board
Operations Check".

uolre|eisul
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Print Board Operations Check

After assembling the print board, perform the procedures presented in the following table to make sure it functions
properly.

m Normal print board operations check

Step

Normal print board operations (points to check)

Multiple copy/
error display

Other points to check

Turn on the power switch.

L s

" flashes after

@ Press twice. (will add to 3 copies)
e _-,’ "will be displayed.

® Press (:) .

" 11" lights up.
2 Open the printer door and attach the supplied
thermal transfer film, then close the printer door. | » 7 » flashes.
®Installing Thermal Transfer Film procedure !
(refer to page 14)
3 Open the paper cover and insert ordinary Letter
test paper, then close the paper cover. " " lights up.
®Loading Copy Paper procedure !
(refer to page 16)
4 Open the printer door. " " flashes.
Close the printer door. " | "lights up.
6 Press D . ® Does the screen film surface
feed smoothly?
® Are there any strange noises?
7 @ Use the supplied marker to draw a large ® Are three copies made?
N T _ ®|s the entire readable area
N filling the entire copyable area of the printed?
. ®During the copying process, are
s.c(r:een fltl)rln surface% t 9 there any strange noises or
opyable area (re er 1o page ) n :’, n |IghtS up. paper jamS? Are multlple sheets

of paper fed through at the same
time?

@ Press D to move the screen film surface.
Write letters, etc. with the marker.

@ Press @ once.

® Press (:) .

®Has the darkness indicator light
turned on?

®|s the image copied properly?

® Are there strange markings on
the copy sheet (e.g., stripes or
lines)?

9

Has the darkness indicator light
turned off?

10

Are two screens copied properly?

o |f the unit fails on any of the check points, please contact your dealer.
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Print Board Operations Check

m Interactive operations check

1 Connect the print board to the PC according to the instructions of page 26 using the
supplied interactive cable.

2 Install the software on the PC according to the instructions of page 27 and check that
the interactive function operates.

* If the Electronic Pen position shifts, adjust the position according to the instructions of page 31.

o

~

Repacking

Perform assembly steps 2 through 4 (refer to pages 73 through 75) in reverse to repack
the print board and accessories. Use the joints to fasten the shipping box to the upper and
lower box.

Joint
® Refer to the shipping box instructions
for information on how to fasten the
‘ f )\shipping Box 16 joints.

~

uolre|eisul
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Assembling the Optional Stand «x-8roes)

m Accessories

The package box for the optional stand includes the parts noted below; please confirm that all parts are present
before beginning installation.

No.| Part name Part illustration |Q'ty[[No.| Part name Part illustration |Q'ty
(1) | stand base 2 || (©@| Wingbolt ) 6
M5012mm (15/32")
- Support
Pipe 2 2
@ P @ bracket @
©) Cover = 2
@ Fall-prevention A
extension leg
@) | side bar ® % 2
(B) | side bar % 1@ Screw W 4
M6060mm (2%/s")
® Screw 5= 2@ Nut o8 4
M8045mm (12/:,")
Fixture ~4 *1
h 2 Wrench 8 1
@ (left) A
Fixture < > 5

(right)

*1 The accessory wrench is required when disassembling the electronic print board; please store
it carefully for future use.

®Before assembly, be sure to lock the casters.

Locking the casters ﬁ
(Push this side) Ny

20

@®

Releasing the lock




Assembling the Optional Stand (KX-BP065)

m Assembly

l Assembling the stand

Assembling the fall-prevention extension legs. .
9 _ p. _ 9 Insert the covers @ to the pipes @
The fall-prevention extension legs increases the safety of the

electronic print board.

o\

/y gj

oY
o\

Fall-prevention extension legs @ Caster locks are attached to
the back side.

Assemble with the
holes toward the front.

O\

o

@ To lock the fall-prevention
extension legs, lift portion A.

Locking
casters side.

Locking casters side.
(rear)

* 1 Do not tighten the screw @ too much. This may deform the pipes.

uolre|eisul
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Assembling the Optional Stand (KX-BP065)

2 Attach the attachment fixtures (7) (8) with the four wing-bolts.

3 Assemble and install the print board.

=> Please refer to assembly instructions on page 74.



Wall-mounting Kit x-8063)

Before attempting installation of this wall-mounting kit, we strongly recommend consulting with the building facility nor

manager, engineer, or architect. The installer needs to know the type of construction used for the wall intended for this
installation and the location of wall studs. Selection of hardware is critical for safe wall-mounting, and dependent upon
the nature of wall construction, installation should not occur until this consultation takes place.

Procedure for KX-B063 Wall-mounting Kit Installation

I .Tools required:

One (1) KX-B063 kit
A minimum of eight (8) pieces of appropriate wall-support hardware (molley, toggle, etc.)
NOTE :THIS HARDWARE MUST BE LOCALLY PROCURED, IT IS NOT INCLUDED IN THE KIT.

Drill (and drill bit of correct size) for hardware installation

Screw driver (Both phillips (+) and slotted (-) will be required.)

Tape measure

Tape or thumb-tacks (2pcs)
Bubble type level

IL .Pre-requisites

1. Before installation, make sure that the wall intended for installation is capable of supporting

flush-mounted.

[ KX-BP800 is 103 kgf (227 Ibs). ]
2. The position of the intended installation is of adequate size for the selected Panaboard.

[ KX-BP800 is 1,575 mm X 1,524 mm (5'2"005").]

3. An outlet is within 3 m (9'10%s."), and it is not located directly behind the Panaboard.

m Accessories
The package includes the parts noted below ; please confirm that all parts are present before beginning installation.

Eight screws for mounting the fixtures on the wall are not provided. Please purchase the appropriate wall-mounting
hardware (sold in stores). Refer to pages 83 and 84.

M5012 mm (15/32")

No use*

Use the wall-mounting
template provided with
KX-BP800.

No.| Partname |Partillustration, Q'ty (())frﬂg(re No.| Partname |Partillustration, Q'ty é)frﬂglra
04
Wall-mounting . < >
@ fixture L H2 @ crew M4016 mm o
No use*
Wall-mounting "= i I
A R 3
@ fixture R o L2 H2
@ Wall-mounting i i 01 | o
template
o> 02
@) | Wing bolt _ No use*

* These are used for other models.

uolre|eisul
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Wall-mounting Kit (KX-B063)

m Wall-mounting procedure

1 Confirm that the wall is strong enough to support the weight of the print board.
(Please refer to page 81.)

Caution:
The wall must be capable of supporting at least
1,005N [ 103 kgf (227 Ibs) ] for KX-BP800.

2 Tape the wall-mounting template to the wall.

® Do not use the template included in the wall-mounting kit (KX-B063), but rather the one included
with the electronic print board (KX-BP800).
® \When taping the template to the wall, make sure it is level.

3 1. Drill holes in the wall for the wall-mounting fixtures. (8 holes total)

2. After removing the wall-mounting template, attach the wall-mounting fixtures with
the appropriate wall-mounting hardware (two screws in each fixture).

® Wall-mounting
template (provided with KX-BP800)

@ wall-mounting \
fixture L T
Q

I

7+
/

762mm (2'6")

C
Wall- / & | ,@ wall-mounting

mounting :i fixture R
hardware*

@ wall-mounting
fixture L

&

v /.

mounting
hardware*

* This hardware must be locally procured, it is not included in the kit.
® Refer to the section "Attaching the wall-mounting fixtures" (pages 83 and 84) for drilling in the wall and
attaching the mounting fixtures.

Mount the print board. (Please refer to page 74.)



Wall-mounting Kit (KX-B063)

m Attaching the wall-mounting fixtures
The electronic print board must be mounted with the method most suited to the material of the wall.
Three methods are presented here.
(Other options may be available in your area.)

® Attaching to metal or concrete walls
Stud plugs (sold in stores) are needed.

Drill bit
Drill eight holes in the wall.

For the correct hole size,
refer to the instructions for
the particular stud plugs
used.

A~

NN

Metal or concrete
wall

,Stud plug
—————— « Insert a stud plug in each hole.

Wall-mounting
fixture

Bolt

Insert each bolt through a
hole in the wall-mounting
fixture and tighten until the
wall-mounting fixture is
securely fixed to the wall.

uolre|eisul
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Wall-mounting Kit (KX-B063)

® Attaching to plasterboard walls
Split-wing toggles (sold in stores) are needed.

Plasterboard

N

split-wing toggle

Wall-mounting

N l _

fixture
{ =N —J Bolt
N

Arms

NG

4
2
4

® Attaching to wooden walls
Use wood screws (sold in stores).

L\v

/Wall-mounting fixture

-

N—T" Wood screw

]

%

Wooden wall

Insert each bolt through a
hole in the wall-mounting
fixture and into the hole in
the wall beneath so that the
arms of the split-wing
toggle are horizontal.

For the correct hole size,
refer to the instructions for
the particular split-wing
toggles used.

After the arms expand, pull
the wall-mounting fixture
out until the arms of the
split-wing toggle grip firmly
into the wall.

Tighten each bolt until the
wall-mounting fixture is
securely fixed to the wall.

For the correct hole size,
refer to the instructions for
the particular wood screws
used.
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